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About CAPTURE v. 4.8.4

Introduction Welcome to CAPTURE, a powerful RAD7 software tool for Macintosh and Windows.
CAPTURE provides the ability to download radon data files from the RAD7. It renders
sophisticated graphs of radon data, and makes it easy to monitor the status of one or more
RAD7s and issue commands for performing a variety of sophisticated tasks.

CAPTURE can perform two-way communication with RAD7 devices containing RADLINK
remote access software. Operating at up to 19.2 kBaud, RAD7 download operations are
quick and easy. It is even possible to obtain RAD7 data remotely by connecting with
CAPTURE over a network.

CAPTURE's extensive graphing features include advanced data navigation, context-
sensitive statistics panels, and extensive selection options. Data may be exported to a
variety of human-readable formats. High-resolution printer output is always just a click

away.
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First time CAPTURE users are encouraged to begin with the Basic CAPTURE Functionality
section, which provides information on connecting to a RAD?7, transferring data records to
the computer, and displaying a radon data graph.

We appreciate your purchase of the RAD7, and we are pleased to offer CAPTURE to help
you get the most out of your investment. More information on DURRIDGE Products,
including the RAD?7, is available at http://www.durridge.com.



http://www.durridge.com/

Installing CAPTURE

System CAPTURE is available for Windows and Macintosh. The Windows version of CAPTURE is

Requirements compatible with Windows XP, Vista, and Windows 7. The Macintosh version of CAPTURE
requires an Intel-based Macintosh running Mac OS X 10.5 or later. The computer must have at
least 1 GB of memory, and a 1 GHz processor. A display resolution of 1024 by 768 pixels is
required, but a larger display is recommended for viewing RAD7 data graphs in high detail.

For CAPTURE to obtain data from a RAD7 using the Keyspan USA-19HS serial to USB
adaptor, it is necessary to install the Keyspan drivers, which are included on the DURRIDGE
Software CD. These drivers are also available at the manufacturer's website.

Installing on To install CAPTURE on Windows, obtain the CAPTURE application installer from the

Windows DURRIDGE website or the DURRIDGE software CD. Launch the installer and follow the on-
screen instructions to install the application. Shortcuts may be placed on the desktop and in
the Start Menu if desired. The installer will offer to launch CAPTURE when the installation is
complete.

s

« CAPTURE Install Program o @ [

Welcome to the CAPTURE Install program.

This program allows you to install CAPTURE on your hard drive.

It iz strongly recemmended that before proceeding, you ensure that
no other Windows programs are running.

If you do not wish to install CAPTURE, click "Exit’ now, otherwise
click "Next' to continue.

< Back [ Next = ][ Exit

Figure 1: The CAPTURE install program on Windows.
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Figure 2: Installing CAPTURE on Windows.

To install CAPTURE on Macintosh, obtain the CAPTURE disk image from the DURRIDGE
website or the DURRIDGE software CD, and mount it on your computer's desktop. Open the
disk image, and drag the CAPTURE application icon onto the nearby alias of the Applications
folder to copy it to your computer. Locate the CAPTURE application in the Applications
folder and drag it to the dock for easy access if desired. Unmount the CAPTURE disk image
after the application has been copied to your computer.
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Drag CAPTURE to the Applications folder to install.

CAPTURE.app Applications

Sample RAD7 Data Files

{DURRIDGE

RADON INSTRUMENTATION

3 itemns, 38.1 MB available ——
Figure 3: The CAPTURE Mac OS X disk image.
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Basic CAPTURE Functionality

This section will introduce the CAPTURE user interface and provide instructions on
connecting a RAD7 to the computer, obtaining data from the RAD7, and displaying a data
graph.

Preparing the RAD7

Make sure the RAD7 contains several valid data records and that it is plugged into a stable
power source and powered On. Use a null modem cable to connect the RAD? to your
computer's serial port. A USB to Serial adapter and compatible drivers should be used if
your computer does not have a serial port. These materials are included with each RAD?.
Alternatively a Bluetooth Serial adaptor may be used to connect to the RAD7 wirelessly, as
explained in the Long Distance Connectivity section. DURRIDGE offers preconfigured
Parani SD-1000 Serial to Bluetooth Adaptors as an optional RAD7 accessory.

The Main Window

When CAPTURE starts up, the Main Window will appear. This window contains controls
used for downloading RAD7 data and performing other RAD7 communication operations,
as well as opening existing RAD7 data files from disk. When the window first appears,
some controls will be disabled. These controls become active only when a connected RAD7
has been detected.

The process of connecting to the RAD7 differs depending on whether the device has
RADLINK installed, as indicated by a sticker on the top of the RAD7. With RADLINK
present, it is possible to download data without having to press any buttons on the RAD7
itself. If your RAD7 does not have RADLINK installed, it will be installed when you return
the device for calibration.
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Figure 1: Scanning for connected RAD7s to add them automatically.

If RADLINK is present on the RAD7, CAPTURE should be able to detect it automatically.
(If it does not, click the Scan For RAD7s button at the lower right corner of the main
CAPTURE window.) A progress bar will appear, tracking the scanning process, and any
detected RAD7s will be added to the windows's tool bar, as shown in Figure 1, above.

If RADLINK is not present, click the ADD RAD? button in the toolbar, which is shown in
Figure 2, below. The Connection Panel will appear, containing controls for specifying the
Connection Type, Serial Port, and Baud Rate, as shown in Figure 3. The Connection Type
pop-up menu should be set to "Serial Port". The other options are for connecting to a
RAD? at a remote location using a dial-up modem or network connection. These options
require additional configuration, and are discussed in the Long Distance RAD7
Communication section. (It is recommended that users first learn how to perform
downloading operations via a direct serial port connection, before moving on to more
advanced remote operations.) The Serial Port pop-up menu should be set to the name of
the port to which the RAD7 has been connected. Finally, the Baud Rate pop-up menu
should be set to the baud rate of the RAD7. For a RAD7 without RADLINK, this will
always be 1200. Once the correct settings have been selected, click the Connect button.
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Figure 2: Adding a RAD7 manually by clicking the Add RAD7 button.
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Figure 3: Specifying connection parameters for a RAD7 that was added manually.

Note that it is possible to manually add a RAD? even if it has RADLINK installed (though
it may be more convenient to let CAPTURE detect it automatically using the Scan for
RAD?7s button.) If RADLINK is installed, the RAD7's baud rate may be checked and
altered using the RAD7's keypad. To do this select the Special menu command on the
keypad and press [ENTER], and then navigate to the SetBaud command and press
[ENTER] again. Use the left and right arrow keys to choose the desired baud rate, and
press [ENTER] a final time to confirm the selection. When downloading manually,
whichever baud rate is chosen on the RAD7 must also be chosen in CAPTURE. If
RADLINK is not installed, the baud rate can not be checked on the RAD?7, but it can be
assumed that the baud rate will always be 1200.

Choosing incorrect settings may result in "garbage data" being received. This is generally
not a major problem, since CAPTURE is able to identify such data and will permit the
interruption of the downloading process before too much useless information accumulates.

Downloading RAD7  Along the left side of CAPTURE's main window is a series of buttons connecting to panels

Data used for performing various RAD7 communication operations. These include Download
RAD? Data, Chart Recorder, Issue RAD7 Command, and Relay RAD7 Commands. After
CAPTURE has connected to a RAD?, a series of brief tests will be performed to determine
which communication operations are possible. A RAD7 containing RADLINK and
connected directly to the computer will permit all possible operations, while a RAD7
without RADLINK installed permits only the Manual Download operation.

Select the Download RAD7 Data panel if it is not already highlighted. A set of controls
will appear for specifying the name and desired location of the downloaded RAD? data,
and whether to display the data in a graph. The Download RAD7 Data panel includes two
additional controls, as shown in Figure 4: the Run Selection pop-up menu, for specifying
which data run(s) to download, and the Obtain Supplementary Data checkbox, for
specifying whether to obtain supplementary data. This additional data includes
information about the RAD7 such as its serial number and calibration date, as well as the
device's printer output records, which offer details that are not always present in the
standard RAD? records. A RAD7 data file containing this supplementary information will
use the R7CDT file name extension, whereas files lacking this supplementary data use the
R7RAW extension.
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Figure 4: Configuring download settings in the Download RAD7 Data panel.

After specifying the appropriate download parameters, click the Begin Download button.
If the RAD7 has RADLINK, the button will be labeled "Begin Download Automatically"
and data will begin arriving almost immediately after clicking it, as shown in Figure 5,
below. Otherwise it will be necessary to start the RAD7 manually.

To start the RAD7 manually, use the RAD7 keypad to choose Data, and then Com. Then
key in the desired run number and press [ENTER]. You will have thirty seconds to
complete this procedure before CAPTURE aborts the download due to an absence of
incoming data.
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Figure 5: A RAD7 data download operation in progress.

As data records are received, they will fill the RAD7 Data text area at the bottom of the
window as shown in Figure 5. When CAPTURE senses that the data retrieval process is
complete, the acquired data will be saved to the specified location on disk. If the Graph
Downloaded Data checkbox is checked, the Graph Window will appear, displaying the
acquired data as shown in Figure 6, below.

If CAPTURE senses that one or more incoming RAD7 Data records are problematic, the
Errors Window will appear containing details on the problem. This is described in depth
in the RAD7 Data Errors section.

Downloading From CAPTURE makes it easy to quickly download all of the raw data from each connected
All RAD7s RAD?7. Once the RAD7s have been discovered, the Download Data From All RAD7s
command will become enabled in the Options menu located on the Main Window toolbar.

Upon selecting Download Data From All RAD7s, the dialog box pictured below will
appear. Click the Select Download Location... button to select the folder into which the
RAD? data will be saved. Next click the Begin Download button. As raw data is obtained,
a message on the lower left corner of the window provides details on the progress.

Once all of the data has been downloaded, the Begin Download button caption changes to
Show Downloaded Files. Clicking this button closes the dialog box and opens the folder
containing the downloaded files.

Download Data From All RADTs

Destination Folder:

Select Download Location... ] E Desktop

Downloading data from 2 RAD7s... 95 data lines received. Begin Download

Figure 6: Downloading data from all connected RAD7s.

Graphing The Graph Window displays radon concentration data across a timeline from left to right,
with periods of higher radon concentration stretching further towards the top of the graph.
In addition to radon, a graph may display thoron, temperature, and humidity data. A
multitude of controls are available for navigating the RAD7 Data graph. These are
discussed in the Graphing RAD7 Data section.

Because the data displayed in the Graph Window has been saved to disk, it is possible to
reopen it at any time, using the Open Data File button on the toolbar, or the Open Data
File... command in the File menu. It is also possible to export the graph data or the graph
image for use in spreadsheets and presentations. For now, save the graph image by




selecting "Save Graph Picture..." from the File Menu. After entering the desired image size,
complete the operation by specifying a name and location for the saved graph image.
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Figure 7: RAD7 data displayed in the CAPTURE Graph Window.



Opening Data From Disk

Besides being able to download data from the RAD7, CAPTURE can also open and graph
existing RAD7 Data Files stored on disk. To do this either choose Open Data File... from
the File menu, or click the Open File button on the Main Window toolbar, which is shown
in Figure 1, below. The Open File dialog will appear, as shown in Figure 2. Here a RAD7
data file may be selected along with other parameters.

CAPTURE comes with a small collection of sample RAD7 data files, making it possible to
explore the program's graphing features without having to first download data from your
own RAD?7. These are located in a folder alongside the CAPTURE application.

& CAPTURE

s, )

Open File Add RADT

#v

Options

Figure 1: The Open File toolbar button.

Radon In Air

The Open File dialog contains a pop-up menu for selecting between multiple graphing
procedures, each involving a different radon source. For graphing standard RAD7 data
collected from the air, the Radon in Air option should be selected. Click the RAD7 Data
File... button to select a RZRAW or R7CDT file to graph. (Information on the various types
of RAD7 Data Files is available in the File Formats section.)

If you wish to open one of CAPTURE's sample files, they can be found in the Sample Data
Files folder, which is located in the same folder as the CAPTURE application. Once a
RAD? data file has been selected, click the Display Graph button. If the file contains valid
RAD? data, the Graph Window will appear immediately. Information about navigating the
Graph Window is available in the Graphing RAD7 Data section.

Open File

Radon Source:

’Radon in Air

7]

[ RAD7 Data File... ] |lu’_ﬁ+ Sample Radon Data 1.r7cdt

[ Cancel ] [ Display Graph ]

Figure 2: The Open File dialog, used for selecting a RAD7 data file to graph.

If there are problems with the selected RAD7 Data File but it is still partially readable,
CAPTURE will graph any valid RAD?7 Data records, and report a list of erroneous data
lines. More information on handling problematic RAD7 Data is available in the Radon
Data Errors section.

RAD AQUA or Water
Probe

If the RAD7 was measuring radon in water using the RAD AQUA or Water Probe
accessory, then it is necessary to specify not only the RAD7 data file, but also water
temperature data, which required to accurately calculate the concentration of the radon in
the water. Water temperature data files are produced by temperature logging devices that
may be present during the duration of the RAD? test. Alternatively, a simpler approach is
to supply a fixed water temperature value which will be applied across all records.
CAPTURE supports both of these options. Note that temperature logger data files are
produced by third party temperature probes. CAPTURE can only open a temperature data
file if its exact format has been defined in the Profiles section of the Preferences Window.

First choose RAD AQUA or Water Probe from the Radon Source pop-up menu, as shown
in Figure 3, below. Next choose the Temperature Source, either Temperature Data File or
Fixed Temperature Value.

If Temperature Data File is selected, click the Temperature Data File button and select a
text-based file containing temperature data records. Note that some temperature data
probes save data to the PC in proprietary binary formats which can not be read by
CAPTURE. These files can however be exported as plain text files using software provided
by the device manufacturer. Once a temperature data file has been selected, identify its
format using the Temperature Data Profile pop-up menu. CAPTURE contains built-in
profiles for several common formats, such as those exported from Onset Computing's
BoxCar and HOBOware, and Lascar Electronic's EasyLog software. Profiles for other
formats must be defined manually. The process of creating new Temperature Data Profiles
is explained in the Preferences Window section.



If Fixed Temperature Value was selected, simply specify the temperature and unit (either
Fahrenheit or Celsius), as shown in Figure 4.

After the appropriate settings have been selected, click the Display Graph button. The
graph that appears will permit the display of Radon in Water, Thoron in Water, and Water
Temperature graph lines, which are unavailable in conventional graphs.

Open File

Raden Scurce:

|RAD AQUA or Water Probe -

[ RAD7 Data File... ] #74 sample Radon Data 1.r7cdt

Temperature Source:

’Temperature Data File - ]

[ Temperature Data File... ] #1,4 sample Temperature Data (Onset BoxCar Tab-Delineated).bd

Temperature Data Profile:

’Onset BoxCar Tab-Delineated Data v] Edit Profiles...

[ Cancel ] [ Display Graph ]

Figure 3: The Open File dialog with the Radon Source set to RAD AQUA or Water Probe, used for graphing radon in water.
Here a temperature data file has been specified.

Open File

Radon Source:

[RAD AQUA or Water Probe -

[ RAD7 Data File... ] k’ Sample Radon Data 1.r7cdt

Temperature Source:

’ Fixed Temperature Value - ]

Water Temperature: 250 *C -

[ Cancel ] [ Display Graph ]

Figure 4: The Open File dialog with a fixed water temperature.

RAD H,0 When opening RAD7 data that was obtained using the RAD H,O accessory, the Radon
Source should be set to RAD H,O in the Open File dialog. Simply specify a RZRAW or
R7CDT file and click Display Graph. Temperature data is not used.

When the graph appears, the Radon In Water graph line may be displayed, revealing valid
WAT mode data points. (Note however that the concentrations of these Radon In Water
data points will simply match the corresponding Radon In Air concentrations). The Water
Temperature graph line may also be displayed, but the Thoron In Water graph line will be
disabled because the brief half life of thoron means it will be undetectable by the time the
water sample is aerated with the RAD H,O.

See the RAD H,O manual for detailed information on interpreting this data, and the
Graphing RAD7 Data section for more information on CAPTURE's graphing features.

Open File

Radon Source:

[RAD H20 -

[ RAD7 Data File... ] ﬁ Sample Radon Data 1.r7cdt

[ Cancel ] [ Display Graph ]

Figure 5: The Open File dialog with the Radon Source set to RAD H,O, used for graphing radon in water data obtained
through the RAD H»,O RAD7 accessory.




BIG BOTTLE RAD If the RAD7 was measuring radon in water using the BIG BOTTLE RAD H,0O accessory,

H,0 then it is necessary to specify the RAD7 data file and water temperature data as described
in the RAD AQUA or Water Probe section above, as well as additional information on the
specific BIG BOTTLE RAD H,O configuration used to obtain the data.

To graph RAD7 data collected with the use of the BIG BOTTLE RAD H;O, first choose
BIG BOTTLE RAD H;O from the Radon Source pop-up menu, as shown in Figure 5,
below, and select a RZRAW or R7CDT RAD? data file. Configure the temperature data
settings as described above in the RAD AQUA or Water Probe section, using either a
temperature data file or a fixed temperature value.

Next specify the RAD7 Type. This may be either a standard RAD7, or a RAD7 with an
oversized dome. Also specify the Drying Unit, which may be one of the following;:

¢ Laboratory Drying Unit

e Active Drystik

¢ Small Drying Tube

¢ Active Drystik and Small Drying Tube
¢ Custom

¢ None (Not Recommended)

If the Custom drying unit is selected, it is necessary to specify the volume of the drying
unit in Liters. The None option is not recommended, because it increases the risk of
moisture entering the RAD7.

After selecting the drying unit, specify the Tubing Volume, Bubble Trap Volume, Head
Space, and Bottle Volume. All of these settings affect the calculation of radon in water with
regard to the volume of air inside the testing apparatus. When using the BIG BOTTLE
RAD H,0 system in its recommended configuration, these four values may be left at their
defaults.

After the appropriate settings have been entered, click the Display Graph button. The
graph window that appears will permit the display of Radon in Water and Water
Temperature graph lines, which are unavailable in conventional graphs. The graph should
indicate a Radon In Water concentration somewhat lower than the Radon In Air
concentration, as shown in Figure 6. Because of thoron's very brief half life, it is not
possible to graph Thoron in Water concentrations obtained using the BIG BOTTLE RAD
H,O. of See the BIG BOTTLE RAD H,O manual for detailed information on interpreting
this data, and the Graphing RAD7 Data section for more information on CAPTURE's
graphing features.

Raden Scurce:

[Big Bottle RAD H20 -

[ RAD7 Data File... ] [V4 BigBottie Data 2011-12-23.7cdt

Temperature Source:

’Temperature Data File - ]

[ Temperature Data File... ] }n’f‘{ Bathroom Calibration Temperautres 2011-12-20 thru 24.txt

Temperature Data Profile:

’Lascar Electronics Easylog Data v] Edit Profiles..,

RAD7 Type:

| Standard RAD7 - h
Drying Unit:

’Laborator}r Drying Unit v]

Tubing Volume: 54 ml

Bubble Trap Volume: 51 ml

Head Space: 15 ol

Bottle Volume: 25 L

Specify Ambient Air Radon:

0.5

[ Cancel ] [ Display Graph ]

Figure 6: The Open File dialog with the Radon Source set to BIG BOTTLE RAD H,O, used for graphing radon in water data
obtained through the BIG BOTTLE RAD H,0 RAD?7 accessory



1200. r

1000. r

600, r

400, r

. Radon

B Radon In Water

e T

Radon [5] Radon [5]
830, = 44, pCi/L 584, = 43, pdifL
12/23/11 3:02 PM 12/23/11 346 PM

RZZRH
pCifL

1272311 12/23/11 12/23/11 12/23/11
3:00 AM 330 PM 4:00 PM 4:20 PM

Figure 7: Typical graph of data obtained with the use of the BIG BOTTLE RAD H,0 RAD?7 accessory. Radon in Water is
represented by the blue graph line. The selected area represents the crucial 20-60 minute range.

Quick Open

CAPTURE offers some quick and easy ways to open RAD? data files. Before connecting to
a RAD?, the Main Window will display an Open File button and an Open Recent pop-up
menu, as shown in Figure 4, below. A list of recently opened files appears is this button,
and is also provided by the Open Recent command in the File menu. Up to ten recently
opened files will be remembered, with the newest items placed at the top of the list.
R7RAW or R7CDT data files may also be opened by dragging them onto the CAPTURE
icon, or by simply double-clicking them. Note that when performing these operations or
the Open Recent command it is assumed that the Radon Source is Radon In Air, and that
the Radon in Water, Thoron in Water, and Water Temperature graph lines are therefore
not able to be displayed. To open a RAD7 data file with temperature data applied, use the
Open File command dialog as explained above.

| & CAPTURE

 * )

&,

Diownload RADT Data

Chart Recarder

Issue RADT Command

OpenFile | | AddRADT

#v

Optiens

Not Connected

Open Data File..

Open Recent -

Scan for RAD7s

R TR TR
-

Manually Connect RAD7

Scan for RADTs

Figure 8: The Open File button and Open Recent pop-up menu in the Main Window.




Graphing RAD7 Data

The Graph Window may appear when new RAD7 Data is downloaded or when an
existing RAD7 Data File is opened. The Graph Window consists of several interface
components, plus side panels containing a Spectrum display and Statistics. Navigational
controls appear in an auxiliary floating window. Each of these elements are described
below.

The Graph Window The Graph Window displays radon data along a coordinate plane, with the X axis
representing time, and the Y axis indicating the radon concentration in any of several
different unit types. RAD7 Data itself appears as a black line, or as a red line in areas of
high relative humidity. (This can be changed in the preferences.) Other graph lines
representing such things as thoron, air temperature, and humidity, may be toggled on and
off using the Graph Controls Window, which floats alongside the Graph Window. This is
explained further below. Gaps in the data occur in areas where no radon samples were
recorded.
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Graph Navigation The Graph Window contains simple but powerful navigational controls which make it
possible to select data points, scroll horizontally through data, and zoom the graph.

Selecting Data

To view a specific portion of the graph in detail, it is first necessary to adjust the selection.
The vertical blue lines in the above screen are called Selection Bars. These lines frame the
selected area. Information pertaining to the selected area is displayed in a panel in the
Statistics panel, which is located alongside the Graph Window. To create a new selection,
simply drag the mouse across a portion of the graph. The selection can then by modified
by dragging either of the Selection Bars. Dragging while holding the Alt (Option) key will
cause the selection to grow from the center.

Zooming the Graph

Double-click on the selected area to to zoom in. Once the view has been magnified, the
selected data will be visible in greater detail, and a red bar will appear under the Selection
Bars. Double-clicking on the Selection Bars when they are red causes the view to zoom out
to its previous state. If the red Selection Bars are dragged, they will turn blue again and
the selection may be changed. At that point, double clicking will cause the view to zoom
in further for still greater detail.

Zooming in and out may also be achieved by using the Zoom Slider which is located on
the floating Graph Controls Window, which appears to the left of the Graph Window by
default. (The Graph Controls Windows is described in greater depth below.) Additionally,
the View menu in the menu bar contains Zoom In and Zoom Out commands, which can
be used repeatedly to move in and out through a wide range of zoom states.




Scrolling the Graph

Whenever the graph is zoomed in, the scroll bar at the bottom of the window will become
enabled, and it will be possible to navigate forwards and backwards through time.

It is also possible to scroll the graph using the Selection Bars. Position the cursor between
the Selection Bars, and hold the Shift key. With the Shift Key pressed, drag the mouse to
the left or right, off the edge of the graph. The graph will scroll to keep up with the
movement of the mouse.

Graph Controls
Window

The Graph Controls Window is used the to navigate the graph and change its behavior
and appearance. Although much of its functionality is also accessible from within the
menu bar, you may find that the Graph Controls Window provides easier access to
commonly used functions. This scrollable window consists of a series of panels, labeled
Configuration, Appearance, Navigation, Graph Lines, and Windows and Panels. These
may be expanded or collapsed by clicking on its heading. Each panel is described below.

Configuration Panel

Graph Controls
|vr figurati |,

Concentration Units:

[Automatic v]

Temperature Units:

[Celsius v]

[~ Foreed SMIFF Mode
|:| Correct For Humidity
[ Correct for B to A Spill

» Appearance
P Navigation
P Graph Lines
P Windows and Panels

RAD?7 Profile Pop-Up Menu

Use this pop-up menu to identify the four-digit serial number of the RAD7 that was used
to collect the data being graphed. This associates the appropriate RAD7 Profile with the
graphed data, allowing for the more accurate display of radon and thoron information. The
collection of RAD7 Profiles may be edited in the Preferences Window, as described in the
Preferences section.

Concentration Units Pop-Up Menu

Determines the unit of measurement used to denote radon and thoron concentrations on
the graph. The available options include Automatic, Bq/L, Bq/m3, dpm/L, and pCi/L.
The Automatic option causes radon and thoron concentrations to be presented in the unit
in which they were originally recorded inside the RAD?.

Temperature Units Pop-Up Menu

Determines the unit of measurement used to denote air and water temperatures on the
graph. The available options include Automatic, Celsius, Fahrenheit, and Kelvin. The
Automatic option causes temperatures to be presented in the unit in which they were
originally recorded inside the RAD?.

Forced SNIFF Mode Checkbox

Determines whether the graph data is forced to be displayed as if it was recorded in
SNIFF Mode. This checkbox is enabled whenever there exists at least one record that truly
was recorded in SNIFF Mode. Such records are analyzed to determine the necessary SNIFF
sensitivity data.

Correct For Humidity Checkbox

Determines whether the graph data is corrected for humidity. When relative humidity is
high, radon concentration values are often underreported. Humidity correction
compensates for this.

Correct for B to A Spill Checkbox

Determines whether correction is applied based on the spill from the B to A windows.
Significant spill occurs when the thoron concentration is high relative to the radon
concentration. Under these conditions it is recommended that the data be corrected to
compensate.

Appearance Panel



Graph Controls

» Configuration -
W Appearance

Point Style:
Line Weight:
Smoothing:

[¥] show Grid Lines
Show Graph Legend

Show Error Bars
Show Selection Average

P Navigation
P Graph Lines
P Windows and Panels

Point Style Pop-Up Menu
Determines the appearance of the data points on the graph. The options are Normal,
Shapes, B&W (Black and White) Shapes, and Hidden. The B&W Shapes option causes the

graph to be rendered in black and white, which is useful when graph image is printed on a
non-color printer.

Line Weight Pop-Up Menu
Determines the thickness of the graph lines, as measured in pixels. This value may range

from 1 to 4, or the graph lines may be hidden. A thicker line may be easier to read, but is
somewhat less precise than a single-pixel line.

Smoothing Pop-Up Menu
Determines the degree of smoothing applied to the graph line. This value may range from

1 (no smoothing) to 9 (high smoothing). When the degree of smoothing is greater than 1,
the original, non-smoothed graph line appears faded in the background.

Show Grid Lines Checkbox

Determines whether horizontal and vertical grid lines are visible on the graph.

Show Graph Legend Checkbox

Determines whether the legend is visible on the Graph Window. The legend indicates the
significance of the colors that appear on the graph.

Show Error Bars Checkbox

Determines whether error bars are visible on the graph. Error bars indicate the uncertainty
of radon and thoron readings.

Show Selection Average Checkbox

Determines whether a representation of the uncertainty in the average of the selection is
displayed between the Selection Bars.

Navigation Panel
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Graph Zoom Slider

Zooms the radon graph in and out. When this slider is dragged all the way to the left, the
entire collection of data is made visible, and no horizontal scrolling is required to see data
points.

Scale Popup Menus

The Radon Concentration Scale pop-up menu determines whether the Y scale of the radon
graph is determined automatically or manually. If Automatic is selected, the graph's Y
scale will be configured such that the visible radon points will occupy the entire available
vertical space. Selecting Manual makes it possible to control the Y scale region yourself.

Also appearing in the Navigation panel are pop-up menus for specifying the Thoron
Concentration Scale, the Temperature Scale, and the Relative Humidity scale. Each behaves
similarly to the Radon Concentration Scale pop-up menu, and may be set to either
Automatic or Manual.

Concentration Scale High and Low Fields

When a Scale pop-up menu is set to Manual, a set of controls for specifying the scale
parameters appears. The High and Low fields represent the highest and lowest element
values visible on the graph respectively. Separate sets of High and Low fields are present
for radon, thoron, temperature, and relative humidity.

Concentration Zoom and Scroll Sliders

To the right of each pair of High and Low fields are a set of controls for zooming and
scrolling the graph's Y Scale. The Zoom Slider, on the left, is controlled by clicking or
dragging the filled region to the desired level; higher levels represent increased zoom. The
Scroll Slider, on the right, operates like any scroll bar; simply drag the box up or down
until the desired region scrolls into view. The height of the scroll box is proportional to the
scope of the currently visible region. As with the High and Low fields, separate sets of
Zoom and Scroll sliders are present for radon, thoron, temperature, and relative humidity.

Graph Lines Panel

Graph Controls
P Configuration =
) Appearance
P Navigation
¥ Graph Lines

Radon
|:| Thoron
Radon In Water
Thoron In Water
|:| Air Temperature
Water Temperature
[ relative Humidity

Meaningful Thoron Threshaold

[P Windows and Panels




Radon Checkbox

Determines whether radon data is shown on the graph. The values of the radon data
points may be affected by any corrections applied in the Configuration panel, as described
above.

Thoron Checkbox

Determines whether Thoron data is shown on the graph. When displaying thoron for the
first time, a dialog box may appear entitled "RAD7 Profile: Thoron Settings", where you
will be prompted to enter Thoron calibration values for the current graphing session. If
you are graphing data for the first time, and are simply learning how to use the program,
it is OK to accept the suggested default values. However we urge you to contact
DURRIDGE Company to receive the optimal Thoron calibration values consistent with the
serial number of your specific RAD7 device. Once these values are known, a series of
RAD? Profiles may be established, as described in the Preferences Window section.

If Thoron data does not appear when this box is checked, a button labeled "Thoron Details"
will appear at the upper right corner of the Graph Window. Clicking this button will
provide an explanation as to exactly why Thoron is not visible, and the option to display
Thoron anyway will be made available.

Radon In Water Checkbox

Determines whether radon in water data is shown on the graph. This checkbox is only
enabled if a temperature data file containing water temperature information has been
loaded along with the basic RAD7 data. This is because it is impossible to determine how
much radon is in water without knowing the water's temperature.

Thoron In Water Checkbox

Determines whether thoron in water data is shown on the graph. As with the Show
Thoron checkbox, clicking this box may result in the "RAD7 Profile: Thoron Settings"
dialog or "Thoron Details" button appearing. As with the Radon In Water checkbox, this
box is only enabled if a temperature data file containing water temperature information
has been loaded along with the basic RAD7 data.

Air Temperature Checkbox

Determines whether air temperature data points are visible on the graph. The temperature
unit used here may be set in the Configuration panel, as described above.

Water Temperature Checkbox

Determines whether water temperature data is visible on the graph. As with the Radon In
Water checkbox, this box is only enabled if a temperature data file containing water
temperature information has been loaded along with the basic RAD7 data.

Relative Humidity Checkbox

Determines whether relative humidity data is visible on the graph. Relative humidity
values are stored as whole integers. Areas of excessive humidity will be identified with a
differently colored radon graph line.

Meaningful Thoron Threshold Checkbox

Determines whether a shaded area will appear representing the area under the meaningful
thoron concentration range. A thoron reading may only be considered meaningful if the
data point appears above this shaded area. If one or more thoron data points are found to
be under the minimum threshold, a dialog box will appear explaining the situation. Non-
meaningful thoron data has high uncertainty, resulting from excessive spill between the
RAD?'s C and B windows.

Windows and Panels

Graph Controls
) Configuration -

) Appearance
P Navigation
P Graph Lines
w Windows and Panels

|:| Show Log Window
Show Spectrum
Show Statistics -

Show Log Window Checkbox
Determines whether the Log Window is visible. This window contains a listing of all of the

actions that CAPTURE has performed since the application was launched, plus a record of
the data that has arrived through each serial port.

Show Spectrum



Determines whether the Spectrum panel is visible. This panel displays a graph emulating
the spectrum printed out by the RAD7.

Show Statistics

Determines whether the Statistics panel is visible. This panel displays a range of
information on the data being displayed on the graph, as well as whichever data lies
within the selected portion of the graph.

Statistics Panel

The Statistics panel consists of four sub-panels, labeled RAD7, Entire Data Range, Selected
Area, and Point Nearest to Cursor. Each of these may be independently expanded or
collapsed as viewing area permits. The Statistics panel itself may be resized and scrolled as
desired. The contents of each panel are described below.
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The first sub-panel in the Statistics panel shows information about the RAD7 from which
the current graph data was obtained. Its heading contains the RAD7's serial number, if it is
known. Note that this and other items may be listed as '[Unknown]' because not all RAD7
data files contain supplementary information with details on the device itself. Generally
files with the R7CDT file name extension offer this supplementary data, while files with
the R7RAW file name extension do not. The exception to this occurs when a RZRAW data
is exported as "Cleaned Up Data"; in this case the resulting R7CDT file contains only what
was able to be synthesized from the original R7ZRAW data.

Entire Data Range Panel

The second sub-panel in the Statistics panel contains information summarizing the entire
range of data contained in the graph, including the average radon, thoron, temperature,
and humidity, as well as the total number of data points and time duration of the data set.

» RAD7 0418 -
¥ Entire Data Range
Avg. Radon: 4030, = 11, Bg/m*
Avg. Thoron: -
Avg, RH: 11.5%
Avg, Temp: 29.1°C
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P Selected Area
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Selected Area Panel

The third sub-panel in the Statistics panel displays information on the selected records, i.e.
those lying between the Selection Bars. The includes the selection's average radon, thoron,
temperature, and humidity, as well as the number of data points selected and time
duration of the selected range.
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Point Nearest To Cursor Panel

The fourth sub-panel in the Statistics panel displays statistics on the data record that the
cursor is touching, if there is one. This includes the record's date, test number, run
number, and cycle number, plus radon and thoron concentrations, as well as temperature
and relative humidity data. Information on the state of the RAD? at the time of the test is
also provided. If the graph contains raw RAD7 data lacking supplementary information,
the Run and Cycle values will be based on estimates. Any problems with the data point
will be reported in the bottom section of the panel.
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Spectrum Panel

The Spectrum panel emulates the spectrum printed out by the RAD?. It is based on the
total counts in each of the windows A, B, C, and D for the selected points in the display.
The count rate is displayed under each peak, and the polonium isotope whose decays
contribute to the peak is indicated at the top.

CAPTURE's Spectrum display is useful for visualizing the growth of counts in window C
as time progresses in a measurement run. Note however that it is not always identical to
the spectrum printed by the RAD7. Specifically, there are various pathological spectra that
may be generated by a malfunctioning RAD7 in which the peaks are not in their correct
position and/or there are spurious points within and outside the primary windows that
are distributed randomly across the entire spectrum (see chapter 3.13.4 of the RAD7
manual). These symptoms would be manifest in a real spectrum printed by the RAD7 but
not in the synthetic CAPTURE spectrum.

Two buttons near the top right corner of the Spectrum panel may be used to display the
spectrum in its normal form, or as a simplified bar chart. Detailed information on the
spectrum is available in the RAD7 User's Manual, Chapter 3.7.
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The Chart Recorder

The CAPTURE Chart Recorder displays a real-time graph of RAD7 data as it is recorded.
As aradon test progresses, a set of virtual pens plot radon concentration, temperature, and
humidity data on the right side of the display, while older readings scroll to the left.

The Chart Recorder is accompanied by a Button Bar for starting and stopping tests and
configuring RAD7 settings. Below the Button Bar is a Status Display panel which indicates
the current state of the RAD7. A nearby panel of Chart Recorder Controls is used to adjust
the appearance and range of the Chart Recorder. These features are described in detail
below.
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Figure 1: The CAPTURE Chart Recorder.

Button Bar The Chart Recorder's Button Bar contains controls for starting and stopping the RAD?,
refreshing the Status Display and Chart, and configuring RAD7 settings.

Start RAD7 Test Stop RADT Test Refresh Status Display Test Options Setup Options

Figure 2: The Chart Recorder Button Bar.

The Start RAD7 Test button begins a RAD7 test and initiates real time data tracking. This
button has the same effect as selecting Test Start on the actual RAD7. Likewise, the Stop
RAD?7 Test button emulates the RAD7's Test Stop function.

The Refresh Status Display button will update the statistics shown in the Chart Status
Display, and will cause the Chart Recorder image to be refreshed. Normally this occurs
automatically every 60 seconds, but the Refresh Status Display button is useful when an
immediate status update is desired.

The Test Options and Setup Options menus, to the right of the Refresh Status Display
button, contain commands found in the RAD7's Test and Setup menus. Selecting one of
these commands will have the same result as entering the corresponding command on the
actual RAD?. These commands are described in Chapter 2 of the RAD7 User's Manual.
Note that Setup menu commands ending with ellipses (...), such as "Units..." and "Clock..."
will present dialog boxes for specifying command parameters, as demonstrated in figures 3
and 4, below.
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Figure 3: The Chart Recorder RAD7 Units Setup dialog.

RAD7 Clock Setup
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Figure 4: The Chart Recorder RAD7 Clock Setup dialog.

Chart Status Display The Chart Status Display maintains real-time statistics on the state of the RAD7, including
the date and time of the next RAD7 reading, the counts that have accumulated since the
last reading was recorded, the previous reading's run number, test number, and radon
concentration, plus the current air temperature, relative humidity, pump current, and
battery voltage.

The Status Display is automatically updated every 60 seconds, notwithstanding the
immediate update that occurs when clicking the Refresh Status Display button. Each time
an update is initiated, it takes about 5 seconds for the latest status information to be
obtained and displayed.

Mext reading: - Previous Reading: Run 20 Test 87 Air Temperature: *C | Pump Current: 0 mA

Accumulated counts: 0 Radon Concentration >219.7 pCi/L | Relative Humidi Battery Voltage: 7.06 V

Figure 5: The Chart Recorder Status Display.

Chart Recorder To the left of the Chart Recorder is a panel of controls similar to those accompanying the
Controls Graph Window, but simplified in functionality. The use of each control is explained below:

Open As Graph Button

Click the Open as Graph button to view the content of the Chart Recorder in a Graph
Window. This makes it possible to examine the data in more detail, apply corrections, and
export it in a variety of formats.

Concentration Units Pop-Up Menu

Determines the unit of measurement used to denote radon concentrations on the chart. The
available options include Automatic, Bq/L, Bq/m3, dpm/L, and pCi/L. The Automatic
option causes radon concentrations to be presented in the unit to which the RAD7 has
been set.

Temperature Units Pop-Up Menu
Determines the unit of measurement used to denote air temperatures on the chart. The

available options include Automatic, Celsius, Fahrenheit, and Kelvin. The Automatic
option causes temperatures to be presented in the unit to which the RAD7 has been set.

Point Style Pop-Up Menu
Determines the appearance of the data points on the chart. The options are Normal,

Shapes, B&W (Black and White) Shapes, and Hidden. The B&W Shapes option causes the
graph to be rendered in black and white.

Line Weight Pop-Up Menu



Determines the thickness of the chart lines, as measured in pixels. This value may range
from 1 to 4, or the chart lines may be hidden. A thicker line may be easier to read, but is
somewhat less precise than a single-pixel line.

Show Grid Lines Checkbox

Determines whether horizontal and vertical grid lines are visible on the chart.

Show Chart Legend Checkbox

Determines whether the legend is visible on the chart. The legend indicates the significance
of the colors that appear on the chart.

Visible Range Slider and Hours Field

The Visible Range slider zooms the Chart Recorder view in and out. When this slider is
dragged all the way to the left, the entire collection of data is made visible. When the
slider is dragged all the way to the right, only the most recently recorded data points
remain visible. The Hours field can be used as an alternative to the slider: input the
desired number of hours and press Enter to set the chart range. Note that the right edge of
the chart always represents the current time.

Radon, Air Temperature, and Relative Humidity Checkboxes

These checkboxes determine whether radon, relative humidity, and air temperature points
are visible on the chart. The radon concentration data that is plotted on the chart is always
taken directly from the RAD7, with no corrections made with respect to spill, humidity, or
other factors.

RAD?7 Printer Present Checkbox

The RAD7 Printer Present checkbox is used to specify whether an infrared printer has
been positioned on the RAD?. If this box is checked, CAPTURE will allow printing to
proceed uninterrupted after each record is recorded. If this box is not checked, updates to
the Status Display will be given higher priority, potentially interrupting end-of-cycle
RAD? printing operations.

Logging Chart
Recorder Data

When the Chart Recorder is active, chart data may be logged to disk in any of several
formats. Clicking the Logging Settings button, which is visible to the left of the chart,
brings up the Logging Settings dialog box, which is shown below. This dialog will appear
automatically when switching to the Chart Recorder of a RAD? that is currently recording
a test, or when initiating a test while the Chart Recorder is already visible.

Within the Logging Settings dialog box, the Select File Location button is used to specify
the name and location of the logged data. Logged data is saved to a .r7raw file, which
may be opened as a graph in CAPTURE at any time. The Log Supplementary Data
checkbox controls whether additional printer output is logged. If this box is checked, a
r7cdt file with more complete records will be created alongside the r7raw file. The Log to
Column Based Text File checkbox makes it possible to log a column or tab-delineated text
file, which may be opened as a spreadsheet for further computation and analysis.

After specifying the desired settings, click the Start Logging button. The Logging Status
light on the Chart Recorder will turn green to indicate that logging is active. It is possible
to return to the Logging Settings dialog at any time by clicking the Chart Recorder's
Logging Settings button. If logging is active, it may be disabled with the Stop Logging
button, found at the lower left corner of the Logging Settings dialog.

Upon disconnecting a RAD? or exiting CAPTURE, the program will save any outstanding
chart recorder data. This process will normally take several seconds, but may be cancelled
if it is necessary to exit CAPTURE immediately.

Note that even if logging is not specifically enabled, CAPTURE will maintain records of
raw Chart Recorder data in the Preferences folder. These files can be revealed at any time
by selecting Show Chart Recorder Logs from the File Menu.

Log to File:
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Stop Logging [ Cancel ] [ Start Logging ]




Special File Operations

The File menu contains commands for performing special operations upon RAD7 Data.
These include exporting radon data, saving data summary reports, and combining multiple
files into a single file containing an larger collection of data. These features are detailed in
this section.

Exporting RAD7
Data

After RAD7 Data has been downloaded or opened from disk and made visible in a graph
window, it may be exported in any of several formats.

The Export Selected Data command in the File menu includes several options for exporting
different types of files, as described below. Each of these will involve only the selected
records, which are those found between the two Selection Bars. More information on using
the Selection Bars is available in the Graphing RAD7 Data section.

Edit View Window Help

Open Data File... Ctrl+0

Open Recent [

Close Ctrl+W

Export RADT Output...

Export Selected Data... » Cleaned Up RADT Data...

save Graph Picture.. Celumn Based Text File...

Combine Data... Colurmnn Based Text to Clipboard...
Show Data File Data Summary...

Page Setup... Ctrl+Shift-P B

Print... Ctrl+P RADT Printer Data...

CAPTURE Preferences... Ctrl+,

Exit Ctrl+Q

Figure 1: Export Selected Data options in the File menu.

Exporting Cleaned Up RAD7 Data

The Cleaned Up RAD7 Data submenu command exports a R7CDT or TXT RAD7 Data File
containing only data that was able to be verified. This file will not produce any fatal error
messages when opened for graphing. Choosing this option will present a Save As dialog
box, in which the name and location of the exported file may be specified, as well as the
file type. The R7CDT file type is native to CAPTURE, while the TXT file type is suitable
for a word processing application. The chosen file type does not affect the actual content of
the file.

Exporting Column Based Text

The Column Based Text File and Column Based Text to Clipboard submenu commands
each produce textual data in a format suitable for importation into Microsoft Excel or
similar spreadsheet application. The Column Based Text File command saves the data to a
text file, while the Column Based Text to Clipboard command simply puts it on the
clipboard, making it possible to paste it into another program.

Both of these operations require flagging the desired fields for inclusion in the exported
data using the Export Column Based Text dialog, shown in Figure 2. Each included field is
exported as a separate column of tab-delineated text. The details of this window are
explained below.
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Column Based Text File

RAD?7 Fields Please select the data fields to export:
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Figure 2: Export Column Based Text dialog

The RAD7 Fields section in the top portion of the Export Column Based Text dialog

contains checkboxes representing the original 23 fields comprising each RAD7 data record.
Below, the Derived Fields section contains additional checkboxes representing properties

generated by CAPTURE. Note that any corresponding uncertainty values indicate
statistical uncertainty; these values do not indicate the absolute uncertainty of the RAD7.

After selecting the desired data fields, use the checkboxes in the section of the window

labeled Configuration to specify whether Forced SNIFF Mode, Humidity Correction,

and/or B to A Spill Correction are applied to any derived data being exported.

Finally, use the Delineation pop-up menu to specify whether the columns of text will be
separated by commas or tab characters. The appropriate choice here will depend on the
requirements of the program that will be used to analyze the exported data.

Once all selections have been made, click the Next button. If a tab-delineated text file is
being produced, the Save As dialog box will appear, where a name and location may be

chosen for the resulting text file. Note that although this data can be imported into a
spreadsheet application or opened in a word processing application, it will not be able to
be reopened in CAPTURE.

Export Data Summary

The Export Data Summary command creates a textual Data Summary file, containing basic
information about the selected records and the RAD7 used to record them. Choosing this
option and clicking Next will present a Save As dialog box, in which the name and
location of the exported file may be specified. A sample Data Summary file is shown in
Figure 3, below.




"SNIFF' Sensitiwvity:
Thoron Sensitiwvity:

RAD7 Data File: RAD7_1.r7cdt
RAD7 : 2641
Calibration Date: 7/5/10
Firmware Version: 2.5f 991128
Model : 712
RADLINK Version: 0252
"NORMAL" Sensitiwvity: [Unknown]

0.00956 cpm/(Bq/m3)
0.177 epm/(pCi/ L)

Avg. Battery Voltage: 7.10 W

Awvg. High Voltage: 2220. V

Avg. HV Duty Cycle: B8.91%

Avg. Leakage Current: 2.86 at 24.8 C
Avg. Pump Current: 0 mai

Lowest Battery Voltage: 7.03 V

BA 5pil11 Factor: 0.0300

CE 5pill Factor: 0.0150

Num. Data Pts:

Time Duration:

103 (Tests 18 to 120)

2 Days, 3 Hrs., 18 Min.

Awvg. Radon: 26.2 +/- 2. Bg/m3
Avg. Thoraon: 65.3 +/- 4. Bg/m3
Awg. RH: 3.42%

Avg. Temp: 24.5 C

Avg. Leakage Current: 2. 80

Avg. Pump Current: 0 ma

Figure 3: Sample Data Summary file

Export Run Summaries

The Export Run Summaries command creates a textual Run Summaries file, containing
information on each run, as shown in Figure 4. Choosing this option will present the Run
Summaries dialog box, as shown in Figure 5. This is used to specify the types of data
included in the Run Summaries file, the type(s) of correction applied to the data, and the
formatting of the columns in the file. Each of these parameters is explained below.

RAD7_data_60305.r7cdt Run Summaries

Parameters:
Concentration Unit: pCi/L
Stafting Cycle: 1
HumiL:th Correction: Yes
Forced SNIFF Mode: Yes
BA Spill Correction: Yes

Run # # Cycles Run Start Run Stop Awvg. Radon Uncertainty
1 34 04,30/05 12:47 PM  05,/03,/05 08:47 AM 1320. 3.

2 111 05,/05/05 09:33 AM 05/07/705 05:04 PM 16.2 0.3
3 91 05,/10/05 11:16 AM 05,/12/05 08:47 AM 59.1 0.7
4 4 07/16/05 06:31 PM 07/16/05 06:56 PM 1.6 1.4
5 3 08,/09,/05 08:55 AM 0B8,/09,/05 09:13 AM 1. 1.

) 180 08/09/05 04:37 PM 08/10/05 10:40 AM 0.92 0.16
7 3 08,/12/05 07:50 PM 0B/ 12,05 08:08 PM 0.5 0.7
3 33 09/30/05 11:44 AM 10/01/705 04:14 AM 0.99 0.17
9 16 11/10/05 03:08 PM 11,/10,/05 04:28 PM 2.3 0.8
10 28 11/16/05 01:21 PM 11/16/05 06:01 PM 2.0 0.4
11 28 11/18/05 09:12 AM 11,/19/05 01:12 PM 4,95 0.26
12 28 11/22/05 08:21 AM 11/23/05 12:21 PM 52.4 0.8
13 28 11/23/05 06:21 PM  11,/24/05 08:22 AM 171. 2.
14 15 12/01/05 11:22 AM  12/01/05 12:37 PM 1.8 0.7
15 4 12/01/05 02:51 PM 12,/01,/05 03:11 PM B811. 70.
16 4 12/01/05 03:23 PM  12/01/705 03:44 PM  706. 70.
17 3 12/01/05 03:57 PM 12/01,/05 04:12 PM 5.7 3.4
13 4 12/01/05 04:41 PM  12/01/705 05:01 PM  500. 50,
19 24 12/02/05 10:55 AM 12/02,/05 12:55 PM 2.3 0.7
20 4 12/02/05 01:17 PM 12/02/705 01:37 PM 350. 50.
21 4 12/02/05 01:55 PM 12/02,/05 02:15 PM 3.6 2.2
22 4 12/02/05 02:28 PM 12702705 0Z:48 PM 170. 33.
23 3 12/02/05 02:59 PM 12/02,/05 03:14 PM 1.6 1.6
24 4 12/02/05 03:27 PM  12/02/05 03:47 PM 6.9 6.
25 10 12/02/05 05:13 PM 12/02/05 06:34 PM 1.8 0.7
26 3 12/07/05 03:06 PM 12707705 03:39 PM 1. 2.

Figure 4: Sample Run Summaries file, Print Formatting.



Export Run Summaries

Data Type Data Source: [Radon in Air ']
Concentration Units: [pCi}'L ']
[¥]Include Thoron Data lAIIThoron Data v]

Configuration Starting Cycle:
[] Apply Humidity Correction
[] Apply Forced SNIFF Mode
[¥] Apply BA Spill Correction

Formatting Format Document For: Delineation:
lSpreadsheet v] ’Tab Character v]
[ Cancel ] [ Mesxt... ]

Figure 5: Export Run Summaries dialog

Data Type Controls

The Data Source pop-up menu is used to specify the source of the concentration averages
included in the Run Summaries file. This may be set to either Radon in Air or Radon in
Water.

The Concentration Units pop-up menu is used to specify the unit of the concentration
averages in the file. This may be set to Bq/L, Bq/m?, dpm/L, or pCi/L.

The Include Thoron Data checkbox controls whether the Run Summaries file will contain
columns listing thoron concentration averages, in addition to radon concentration averages
for each run.

Configuration Controls

The Starting Cycle pop-up menu is used to specify the first cycle from each run that is
included in the average. For example, if this menu is set to 3, then the reported
concentration average for a run containing ten cycles would be calculated based on runs 3
through 10. Note that runs recorded in WAT mode or GRAB protocol are exempt from
this rule.

The Apply Humidity Correction, Apply Forced SNIFF Mode, and Apply BA Spill
Correction checkboxes determine which correction(s) are applied to the concentration
averages reported in the Run Summaries file. Similar controls are found in the Graph
Controls Window, and more information about corrections can be found in the Graph
Controls Window section.

Formatting Controls

The Format Document pop-up menu has two options, Print and Spreadsheet. If Print is
selected, the document will be laid out in an easy to read format, as shown in Figure 4.
The Spreadsheet option produces a file that is not as easily readable, but better suited for
data analysis applications. If this option is selected, the Delineation pop-up menu appears,
making it possible to specify whether the document's columns will be separated by
commas or tab characters.

Export Printer Data

The Export Printer Data command saves a textual Printer Data file, containing the
supplementary printer data associated with each record. This information is not available
for all data sets. Choosing this option will present a Save As dialog box, in which the
name and location of the exported file may be specified.

Combining RAD7

To combine two or more RAD7 Data files into a single file, choose the Combine Data...



Data

command from the File menu. The Combine Data window will appear as shown below.

The Combine Data Window contains a list of RAD7 data files to be combined. This list can
be edited using the Plus and Minus buttons to add and remove RAD7 data files. The
Maximum permitted record separation combo box is used to specify the threshold under
which records from different files will be merged and averaged.

The Graph Combined Data and Save Combined Data to Disk checkboxes are used to
specify whether the combined data will be graphed and saved, respectively. At least one of
these options must be chosen, and at least two RAD7 data files must be added to the list
in order for the combining process to proceed. If the combined RAD7 data is to be saved
to disk, use the Select Location button to specify a name and location for the new RAD7
data file.

& Combine Data Ell?@

Add two or more files to combine.

Sample Radon Data 1.r7cdt
Sample Radon Data 2.r7 cdt

e

Maximum permitted record separation: 2 ~ Min.

Records separated by fewer than the specified number of minutes are averaged.

Graph Combined Data

Save Combined Data to Disk

[ Select Location... ] tgj-i

ChUsers\User\Desktop\Combined RADT Data.ricdt

[ Cancel | [ Continue .

Figure 6: Combine Data dialog

Once the desired settings have been chosen, click Continue to complete the combining
process. If there are any problems with the files being combined, the Errors Window will
appear explaining the issue in detail. Only severe data formatting problems will prevent
the combining process from being completed successfully. More information is available in
the RAD7 Data Errors section.

Printing RAD7 Data

When a Graph Window is visible, the radon graph can be printed at high resolution.
CAPTURE's print commands are located in the File menu.

The Page Setup command is used to configure print settings. Before printing a radon
graph, it may be useful to choose the Page Setup command and set the page orientation to
Landscape, so that the graph will fill the page more effectively. The keyboard shortcut for
this operation is Control/ Command-Shift-P.

The Print command prints the current radon graph. On the Macintosh, the Print dialog box
may also be used to save, fax, or email a cross-platform PDF version of the graph image.
The keyboard shortcut for this operation is Control/ Command-P.



Issuing RAD7 Commands

Any RAD7 that has had RADLink installed may be controlled by a computer. The
computer may be connected to the RAD? directly, or it may be connected via a local
network, a dial-up modem, or the local network. RAD7 commands allow for much more
than the simple downloading of data: it is also possible to start and stop testing runs,
obtain data summaries, configure the RAD7's numerous settings, and obtain the RAD7's
serial number and calibration date. In fact, any command available on the RAD7's physical
keypad may be issued from within CAPTURE, whether the machine is located across the
room or across the continent.

Setting Up

The easiest way to issue RAD7 commands, albeit the most restrictive, involves connecting
the computer directly to the RAD7 by means of a serial cable, and, if necessary, a serial to
USB adaptor. This configuration is identical to that used when downloading RAD7 data,
and it is described in in the Basic CAPTURE Functionality section.

Issuing commands from a more distant location can be achieved through the use of local
area networks, dial-up modems, and a local network. It is not practical to describe every
one of the myriad possible modem and network configurations, but typical connection
scenarios are explained in the Long Distance RAD7 Communication section. It is
recommended however that users first learn how to issue RAD7 commands via a direct
serial connection, before moving on to more advanced operations involving dial-up
modems or networks.

Capture Settings

After connecting the RAD7, launch CAPTURE and select Issue RAD7 Command from the
Main Window's Category panel. The Connection Method pop-up menu should be set to
the appropriate connection interface, normally Serial Port, in which case the Serial Port
pop-up menu should be set to the port containing the RAD?. If no ports are listed in this
menu, click the Scan for RAD7s button, in the lower right corner of the Main Window.
Any connected RAD7s containing RADLink will be detected and added to the menu. Once
a valid serial port has been selected, a green checkmark icon will appear to the right of the
Serial Port pop-up menu.

Next, choose one of the preset commands from the RAD7 Commands Combo Box. You
may also enter RAD7 commands not present in the list of presets by typing them
manually. A complete list of RAD7 commands is available in Chapter 2 of the RAD7
User's Manual. After a command has been selected or entered, click the Issue button to
send the command to the RAD7.

The sent command will appear in the RAD7 Output text area, followed by any response.
In the screen shown below, the user has issued the Special Status command, and the RAD7
has responded with details on its current condition.

For another typical example, suppose you wanted to obtain the information that the RAD7
normally sends to its wireless infrared printer. To achieve this, choose "Setup Format
Long" from the RAD7 Commands menu and click Issue. Then to initiate the data transfer
select "Special SprAll" and click Issue again. (Using the "Long" format ensures that all
available details will be included in the transmission.)

Additional commands may be issued at any time, and the contents of the RAD7 Output
text area may be copied to any text editor for archival or printing. Alternatively, the text
may be saved to a file by choosing "Export RAD7 Output" from the File menu.
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Figure 1: Issuing commands via a serial port

Finishing When the session is complete, the RAD7 may be disconnected and shut off. Any
information in the RAD7 Output text area may be copied to the clipboard and pasted into
a word processor or other application for future reference.

Note that the above information applies to direct serial connections; additional steps are
needed to initiate and complete communication sessions involving dial-up modems or
networks. See the Long Distance RAD7 Communication section for details.




Long Distance Connectivity

Under normal circumstances the RAD7 will be connected to the computer running
CAPTURE directly, using a null modem cable and a USB to serial adaptor, if necessary.
When the RAD7 is in a dangerous or remote environment however, it may be desirable to
connect to it from a distance. This can be achieved via a Bluetooth adaptor, a dial-up
modem, or a network. This section explains how to properly configure the RAD7 and
CAPTURE for long-distance communication.

Once CAPTURE has established a connection with a remote RAD7, CAPTURE operation
such as downloading and chart recording will proceed as they would normally. While
Bluetooth-enabled RAD7s may be detected by CAPTURE automatically, other long
distance connection methods require clicking the Add RAD7 button and using the
Connection Method pop-up menu located at the top of CAPTURE's Main Window to
choose the desired connection protocol.

Bluetooth The simplest way to connect to a RAD7 remotely is through a Serial to Bluetooth adaptor

Communications attached to the RAD7's serial port. Since such adaptors create virtual COM ports in much
the same way as a Keyspan USB to Serial adaptor, connecting to a Bluetooth-enabled
RADY?7 is as simple as clicking the Scan for RAD7s button in the CAPTURE window.

DURRIDGE offers the SENA Parani SD1000 Serial to Bluetooth adaptor, preconfigured for
use with the RAD7, making the connection process very straightforward. Other adaptor
products may be used as well, however they must first be set to operate at the RAD7's
specific baud rate. Third party adaptors must also be configured as "discoverable", and any
command response behavior must be disabled to avoid corrupting the RAD7 with garbage
data. The procedure for completing this configuration will vary by adaptor. DURRIDGE
provides detailed instructions on using the SENA Parani SD1000 Serial to Bluetooth
adaptor with the RAD7. Please see the RAD7 Bluetooth Connectivity guide for details.
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Figure 1: A RAD7 connected using a Serial to Bluetooth adaptor will appear on one of the computer's serial ports.

Dial-Up Modem Communicating with a RAD7 over a distance exceeding the 100 meter range of Bluetooth

Communications is perhaps best accomplished through the use of a pair of dial-up modems. This solution
requires that active phone lines exist near both the RAD7 and the computer issuing
commands. Dial-up Internet service is not required. One of the modems must contain a
serial port connection so that it may be plugged into the RAD?7. The other modem must be
compatible with the computer issuing commands. An internal computer modem is
perfectly adequate.

The modem attached to the RAD7 must first be configured to auto-answer, and its baud
rate should be set to 9600. Additionally, command echoing should be disabled to avoid
feeding garbage data into the RAD7. (Check your modem's instruction manual for details,
as this process may vary depending on manufacturer.) This modem will be used to relay
commands to the RAD7, and any responses will be relayed back to the computer issuing
the commands. Before turning on the RAD7, Launch Capture on the remote computer and
click the Add RAD? button. The Connection Type pop-up menu should be set to "Dial Up
Modem". Select the serial port to which the local modem is connected. Enter the phone
number for the line to which the RADY7 is connected, and click Connect.

The RAD7 will respond to any command it receives, whether the command is valid or
invalid. In fact, the RAD7 will even attempt to respond to any "noise" data that it
overhears as the modems begin connecting to each other and engaging in the
"handshaking" process. In such situations the RAD7 will send an error code back out
through the attached modem, causing two-way data flow which can unfortunately disrupt
the connection attempt. In severe cases, the RAD7's RADLink installation may even
become corrupted. It is important therefore to keep the modem's command echoing off, or
to keep the RAD?7 itself turned off until the handshaking process has been completed, as
signified by the ceasing of audible modem noise. A dialog box will appear when it is safe
to turn on the RAD7.

Once the RAD? is turned on, use its keypad to enter the Special menu. Select the SetBaud
command and set the RAD7's baud rate to 9600. (Note that RADLink must be present on
the RAD?.) Back in CAPTURE, perform the desired downloading or command issuing
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operations, proceeding as you would when connecting to the RAD7 directly via a serial
cable.

When finished, it is necessary to first turn off the RAD7, and then disconnect it from
CAPTURE. At that point the session is complete and the modems may be powered off.
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Figure 2: Connecting to a RAD7 using a dial-up modem.

Network
Communications

Communicating with a RAD? that is not directly attached to the computer running
CAPTURE may also be achieved by connecting the RAD? to a local area network. This
may involve connecting the RAD7 to a nearby laptop or other computer, but for the sake
of increased mobility and security the RAD7 may also be connected to a Lantronix WiBox®
or similar portable Internet-enabled device. In either case, the machine connected to the
RAD?7 receives commands sent from a computer running CAPTURE, and immediately
relays them to the RAD7. Once the RAD7 has received a command, the response is
relayed back to the computer running CAPTURE.

We will assume for now that all of the required equipment exists within a local area
network, or to the Internet by means of a nearby computer, and that the connections do
not involve routers or other security equipment impeding communication between
devices. (Contingency plans for dealing with routers are outlined later in this section.)

Launch CAPTURE on each computer. On the computer not connected to the RAD7, click
Add RAD?. The connection panel will appear as shown in Figure 3, below. In the IP
Address field, enter the IP address of the computer to which the RAD7 is directly
connected. Determining a computer's IP address differs depending on the operating system
and the scope of the network. The RAD7 Serial Number should be set to the serial number
of the remote RADY.

& CAPTURE

¢ | &

£

gy_,

Open File || Untitled RAD7

°© %

Add RAD7 Options

Connection Type: ’Internet

.] IP Address:  192168.1.7 RAD7 Serial Number: 2202

Figure 3: Connecting to a RAD7 using the Internet.

On the computer that is attached directly to the RAD?, enter the Relay RAD7 Commands
panel as shown in Figure 4. Click the Listen button to prepare to receive remote
commands. This will allow any commands received by the computer to be passed on to
the RAD7, where they will be acted upon. Once CAPTURE is listening for incoming
commands, the Listen button will change to Stop.
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Figure 4: Relaying RAD7 commands.

Once the relaying computer is listening for incoming RAD7 commands, click Connect on
the other computer. (It is important to click Listen first, then Connect, to avoid errors.)
After the connection has become active, operations may be performed in the same manner
as if there was a direct serial connection between the remote computer and the RAD7's. To
end a session, either click the Disconnect button in the copy of CAPTURE that is running
on the remote computer, or click Stop on the copy of CAPTURE that has been relaying the
commands.

Advanced
Configurations

Real world conditions are frequently more complex than those described in the above
scenario. Often it is impractical to place a proper computer- even a laptop- in the field
alongside a RAD?. This situation calls for the use of a WiBox® or similar portable Internet-
enabled device which can be used to relay RAD7 commands. Since such devices may lack
input controls and screens. They are normally configured via remote interfaces, the details
of which are outside the scope of this manual. Once a device has been configured
however, it will serve the same function as a computer that has been set up to relay
commands, and the process of issuing those commands will be the same as when a full
computer is performing the relaying role.

A second complicating factor is the presence of routers, on either the sending end or the
receiving end of the connection. Routers isolate the devices under their command from the
broader Internet, assigning them location-specific IP addresses that are meaningless to
computers in the outside world. When sending data intended for a device behind a router,
it must instead be sent to the router itself, which has a publicly meaningful IP address and
which handles the responsibility of forwarding the information along to devices it has
identified within its own network. Your network administrator can assist with specific
routing needs.



The Preferences Window

Many important customization options are made available in the CAPTURE Preferences
Window. This window is accessed from the File Menu on Windows, and from the
Application Menu on the Macintosh. The Preferences window consists of multiple panels,
the contents of which are described below.

General Panel

The General panel contains controls for specifying how CAPTURE behaves when
connecting to RAD7s, downloading RAD7 data, and formatting the downloaded
information. These controls are described in detail below.

General

'f.'._ CAPTURE Preferences o] = @ﬁ

J) ) > &) o @)

Profiles Colors Image Output Alerts Laﬁguage Security Updates

Date Format

@ Month/Day/Year
) Day/Month/Year
1 Year/Month/Day

Example: 11/18/2011

RADT Detection

Scan for Connected RA&D7s at Launch

Numerical Precision

[ Match Significant Figures to Precision

Uncertainty Calculation for Average of a Selection U
@ Base Uncertainty on Mumber of Counts

_) Base Uncertainty on Scatter of Points

[ Restore Default Preferences ]

Date Format

The radio buttons in the Date Format section is used to specify the format used to display
dates throughout the application. Dates may be displayed with the year, month, and day
figures ordered in any of three different arrangements.

RAD7 Detection

The Scan for Connected RAD7s at Launch checkbox in the RAD7 Detection section is used
to specify whether CAPTURE identifies all connected RAD7s when it starts up. If this box
is left unchecked, it will be necessary to click the Scan For RAD7s button in the Main



Window before performing an automatic download or issuing or relaying RAD7
commands.

Precision

The Match Significant Figures to Precision checkbox is used to specify whether the base
values of reported concentrations are expressed using fewer significant digits when the
associated uncertainties are high. If this box is checked, uncertainties of 15% or more will
reduce the number of significant digits used by 1, while uncertainties of 150% or more
reduce the number of significant digits used by 2.

Uncertainty Calculation

There are two Uncertainty Calculation options: Base Uncertainty on Number of Counts,
and Base Uncertainty on Scatter of Points. Basing the uncertainty on the Number of Counts
involves Poisson statistics, and is applicable even when there is a significant variation in
radon concentration during the period of the measurement. Basing the uncertainty on the
Scatter of Points is applicable when there are more than ten readings and it is known that
the radon concentration was steady during the period selected.

Please note that the uncertainty, as displayed, refers only to the statistical uncertainty of
the result. This is a measure of the precision of the reading. The result ignores any
systematic bias due to uncertainty in the calibration, and traceability to national standards,
which may be as much as +5%.

Profiles Panel

RAD?7 Profiles

The Profiles Panel contains two tabs: RAD7 Profiles and Temperature Data Profiles. RAD7
Profiles define the characteristics of individual RAD7s and affect how the RAD7 data is
interpreted. Temperature Data Profiles contain file format definitions that make it possible
for CAPTURE to read the output of external third party temperature data loggers. This is
necessary when measuring radon in water, because the temperature of the water must be
known to derive its radon concentration. RAD?7 Profiles and Temperature Data Profiles are
explained in detail below.

Data can be more accurately interpreted and displayed on the graph if certain information
is available on the RAD7 that recorded the data. This RAD7 information is encapsulated in
a RAD7 Profile, any number of which may be specified within the Preferences Window's
RAD? Profiles tab. The list box on the left side of the RAD7 Profiles tab contains the
names of one or more RAD7 Profiles. Highlight a setting in this list to edit it. When
graphing a particular RAD?'s output, the associated RAD7 Profile should be selected in the
Graph Controls Window, ensuring the accurate representation of data.

Although the supplied Default RAD7 Profile may be the correct match for your RAD7, it is
recommended that users contact DURRIDGE to receive the exact profile specification for
each RAD? in use. Be sure to have your RAD? serial number on hand when contacting
DURRIDGE, as this number is used in determining the optimal values to be entered into
the various fields of the RAD7 Profiles panel.

The Plus (+) and Minus (-) buttons under the list box are used to create and delete RAD7
Profiles. If more than one RAD7 device is commonly in use with the same computer, it
may be beneficial to establish multiple RAD7 Profiles, each tailored toward a specific
device.

Once you have established one or more RAD7 Profiles in the Preferences Window, the
Thoron Settings dialog box will no longer appear each time a Graph Window is opened
and Thoron is displayed. You may return to the Preferences Window at any point to
modify the collection of RAD7 Profiles.

Each control in the RAD7 Profiles tab is explained below.
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0010
0011

Identification

RADT Mame:

RADT Serial Mumber:

Radon Settings

EA Spill Facton:

Thoron Settings

CB Spill Factor:

Sensitivity Calculation:

Thoron Sensitivity:

Derived Values [None]

‘MORMAL' Sensitivity:

'SMIFF Sensitivity:

Thoron Sensitivity:

Configure RADT Profiles based on calibration report data. Contact DURRIDGE Company for RADT calibration

Main Lab RADT

2813

0.03

0.015

Use Half SNIFF Sensitivity

0,100 cpmy/(pCi/L)

0,543 cpm/ipCifL) _
00147 cpm/[Bg/m?]
0.270 cpm/[pCifl)
0.00728 cpm/[Bg/m”)
0.135 cpm/ipCifl)
0.00364 cpm/[Bg/m)

Identification

The Identification section consists of fields containing the name and serial number of the
associated RAD7. The text entered in the RAD7 Name field will be used to label the RAD7
icon that appears in the Main Window toolbar. The RAD7 Name field may be left blank;
an unnamed RAD7 will be referred to by its unique serial number. The appropriate serial
number can be found by looking on the top face of the RAD?7.

Radon Settings

The Radon Settings section contains a single field, BA Spill Factor. This factor allows for
the correction of radon readings in the presence of high thoron.

Thoron Settings

The Thoron Settings section consists of the CB Spill Factor field and a set of controls for
specifying Thoron Sensitivity. The CB Spill Factor field allows for the correction of thoron
readings in the presence of radon. The Sensitivity Calculation pop-up menu is used to
specify whether the Thoron sensitivity will be automatically set to half the SNIFF
sensitivity, or whether it will be entered manually. If the RAD7 has been specifically
calibrated for Thoron, select Apply Calibrated Thoron Sensitivity, and enter the thoron
sensitivity value in the field below. Otherwise, leave the Sensitivity Calculation menu set
to Use Half SNIFF sensitivity.

Derived Values




Temperature Data
Profiles

The Derived Values section contains values computed by analyzing the current graph
window with respect to the selected RAD7 Profile. If no graph window is present the
Derived Values will remain unspecified. The Derived Values may not be edited.

When a RAD?7 is used to collect radon data from an underwater source, the water
temperature must be accounted for in order to determine the exact radon concentration.
CAPTURE can perform the necessary calculations to achieve this, however the temperature
data must be provided separately from the RAD7 data. The RAD? itself is not equipped to
record water temperatures.

Measuring the water's temperature can be achieved through the use of a third party
temperature logging device with a serial or USB interface. Once temperature data as been
recorded to the device, the data must be transferred to a computer and saved as a text-
based data file. Software for achieving this is generally provided by the manufacturer of
the logging device.

CAPTURE can only interpret temperature data properly if it given a complete definition of
the format in which the data is stored. The Preferences Window's Temperature Data
Profiles tab provides controls for specifying these formats.
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Temperature Data Profiles

Temperature Data Profiles determine how different types of temperature data files are parsed. Different temperature
probes may output data in different formats, depending on vendor.

Onset BoxCar Tab-Delineated Data Mame:  Onset BoxCar Tab-Delineated Data
Onset BoxCar Tab-Delineated Data Ex...
Onset HOBOWare C5Y Data Starting Row: 1 Record It [Not Specified "l
Lascar Electronics Easylog Data
Separaton lTab v] Date: [Column 1 vl
Temp. Unit: lcelsius v] Temp: [Column 2 Vl

Date Format: ’ Month/Day/Year - ]

[ Replace Sample Data... ]

Sample Data:

Date Temperature
07/15/10 16:57:20.0 3031
07/15/10 16:57:25.0 32.34
07/15/10 16:57:30.0 3317
07/15/10 16:57:35.0 33.59
07/15/10 16:57:40.0 34,01

Sample Result:
Record ID: [Mot Specified]
Date: Thursday, July 15, 2010 4:57:20 PM

el

Temperature: 30.31°C

The Temperature Data Profiles list on the left side of the window contains the names of
each profile. CAPTURE comes bundled with a small collection of built-in profiles, which
allow it to read data exported from temperature loggers manufactured by Onset Computer
Corporation and Lascar Electronics. Exporting features allow the data to be saved to a text
file using either tab- or comma-delineation to separate the various data fields. Other
suppliers of temperature logging devices offer similar software, but since CAPTURE lacks



an exhaustive collection of Temperature Data Profiles, it is sometimes necessary to define
additional formats before temperature data can be utilized.

The Plus (+) and Minus (-) buttons under the list box are used to create and delete
Temperature Data Profiles. Each profile consists of several properties, including Name,
Starting Row, Separator, Temperature Scale. Profiles also contain information indicating
which columns are used for storing the Record ID, the Date, and the Temperature data
itself. All of these can be modified using the controls on the right side of the window,
which are described below.

Name Field

The Name field contains the name of the selected Temperature Data Profile. Temperature
Data Profiles should be given easily recognizable names, such as "Onset HOBOWare CSV
Data". In this example, Onset is the name of the company that supplied the temperature
logger, HOBOWare is the name of the software that is used to extract the data from the
logger, and "CSV" indicates that the data is stored using the command Comma Separated
Values delineation format.

Starting Row Field

The Starting Row Field indicates which row contains the first line of actual data. For
example, if the first line of a data file contains the column headings, then the Starting Row
is likely row 2. In some cases the file's header may occupy two or more lines, increasing
the Starting Row accordingly.

Separator Pop-Up Menu

The Separator Pop-Up Menu is used to specify whether data fields are separated by
commas or tab characters. Commas have become a popular delineation character in recent
years, with the growth of the CSV ("Comma Separated Values") format.

Temp. Scale Pop-Up Menu

The Temp Scale Pop-Up Menu is used to specify whether temperature data is stored in the
Fahrenheit or Celsius scale.

Record ID Pop-Up Menu

The Record ID Pop-Up Menu is used to specify which data column contains Record ID
numbers. Record IDs are usually numbered in ascending order.

Date Pop-Up Menu

The Date Pop-Up Menu is used to specify which data column contains dates and times.
This information should be in a standard format; for example 09/06/10 06:09:37.0.

Temp. Pop-Up Menu

The Temp. Pop-Up Menu is used to specify which data column contains temperature data.

As you configure a Temperature Data Profile's properties, it may be useful to load sample
temperature data for the purpose of validating the accuracy of the definition. To do this,
click the Replace Sample Data button and select a text-based temperature data file. If the
profile's properties have been specified correctly, the Sample Data chart will be filled with
organized, identifiable data, and descriptive headings will appear at the top of each
column. The Sample Result section at the bottom of the window will contain a reasonable
summary of the selected Sample Data record.



Colors Panel

The Colors panel provides access to controls for customizing the colors used when
rendering graph lines. The Colors panel also contains controls for adjusting the opacity of
graph content, and restoring the default color settings.
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Graph Line Colors

Radon

Radon, RH Corrected

- Radon, High RH

Thoron

- Thoron, RH Corrected

Line Opacity
Lightened Graph Line Opacity f
Grid Line Opacity f

[ Restore Default Colors

]

Radon In Water

Thoron In Water

Air Ternperature

Water Temperature

Relative Humidity

25%

25%

Graph Line Colors

Colors for each graph line can be changed by clicking the corresponding rectangle and
selecting a replacement color from the standard system color picker.

Lightened Graph Line Opacity Slider

The Lightened Graph Line Opacity Slider is used to control the opacity of the rough data
lines that appear in the background of the graph when smoothing is enabled.

Grid Line Opacity Slider

The Grid Line Opacity Slider is used to control the opacity of the horizontal and vertical
grid lines that may be displayed in the background.

Restore Default Colors Button

The Restore Default Colors button removes any custom colors and reverts to the original

color settings.




Image Output Panel The Image Output panel provides access to controls for customizing the appearance of

graph images that are printed and saved to disk.
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Graph Printing
Highlight Selected Region On Printout
Show Statistics On Printout
Copying Graph Pictures
Highlight Selected Region On Copied Image
Saving Graph Pictures
Highlight Selected Region On Graph Picture
Highlight Selected Region On Printout Checkbox
Determines whether the selected region is highlighted on the printed graph output.
Show Statistics On Printout Checkbox
Determines whether statistics pertaining to the selected region appear on the printed
output. Note that these statistics can only appear if the printout uses a portrait orientation.
Printed graphs that use the landscape orientation take up the entire page, leaving no room
for statistics.
Highlight Selected Region On Copied Image Checkbox
Determines whether the selected region is highlighted on the image when it is copied to
the clipboard.
Highlight Selected Region On Graph Picture Checkbox
Determines whether the selected region is highlighted on the image when it is saved to
disk.
Alerts Panel The Alerts panel contains controls used to specify which common alert messages are

disabled. Each individual message can also be suppressed by clicking its "Do not show this
message in the Future" checkbox before dismissing it. The purpose of each alert message is
described under the checkbox used to disable it.




& CAPTURE Preferences o @ [

« 9 2 = @ o @

U

General Profiles Colors Image Output Alerts Language Security Updates

Disable the following alert messages:

[]'Configure Thoren Settings' Prompt

Prompts user to enter thoron calibration values when this information has not yet been
specified as part of a RADT Profile.

[7] 'High CB Spill' Warning

Displays an alert message when there is a large amount of spill between the Cand B
windows, which results in high thoron uncertainty.

[7]'Mo RADTs Found' Warning

Displays an alert message when a RADT scan detects no connected devices.

[7]'Scan For Connected RADTs' Prompt

Prompts user to scan for connected RADTs when initiating operations requiring RADLINE
connedctivity.

[T 'Low Baud Rate' Warning

Displays an alert message when the connected RAD7 has a low baud rate, and provides an
option for increasing the rate,

Language Panel The Language panel provides access to controls for specifying which language(s) are
available to CAPTURE.
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Language Settings
Language Selection Options:

@ Allow Operating System to Decide
Permit Machine Translated Languages

(") Use English Only

Allow Operating System to Decide Radio Button

The Allow Operating System to Decide radio button allows the operating system to decide
which language to use.



Permit Machine Translated Languages Checkbox

The Permit Machine Translated Languages checkbox permits machine translated languages
to be used. Note that these languages may contain grammatical errors.

Use English Only Radio Button

The Use English Only Radio Button sets CAPTURE to use only the English language.

Security Panel

The Security panel provides access to controls for protecting RAD7s from commands
issued by unauthorized Internet Protocol (IP) addresses.
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Relay RAD7 Command Security

These settings are used identify the computers that will be permitted to send
commands to connected RADTs.

(71 Accept Commands From All IP Addresses
@ Only Accept Cormnmands From Permitted IP Addresses

Permitted IP Addresses::

19216511
192.1658.1.2

[ )+]

Relay RAD7 Command Security

The Relay RAD7 Command Security controls are used to identify the computers that will
be permitted to send commands to connected RAD7s.

If the Accept Commands From All IP Addresses radio button is selected, commands may
be relayed to a connected RAD7 regardless of the IP address of the computer sending the
commands.

If the Only Accept Commands From Permitted IP Addresses radio button is selected, then
only computers using the IP addresses that have been entered into the Permitted IP
Addresses list will be allowed to issue commands. Use the Plus (+) and Minus (-) buttons
to add and remove addresses from the list.

Updates Panel

The Updates panel provides access to controls for checking to see if updates are available
for CAPTURE. It is also possible to configure CAPTURE to check for updates
automatically.
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Scheduled Update Checking

[] Check For Updates Daily w7

Last Check: Thursday, May 19, 2011 5:49 PM
Mo software updates were available,

[ Check Now ]

Check For Updates Checkbox
Determines whether CAPTURE will automatically check for updates at scheduled intervals.

When an update becomes available, a button labeled Update Available will appear in the
lower right corner of the Main Window. Clicking this button initiates the updating process.

Check frequency Pop-Up Menu

This pop-up menu determines how often CAPTURE performs automatic checks for
updates. CAPTURE may be set to check for updates every time it opens, daily, weekly, or
monthly.

Check Now Button

Checks for CAPTURE updates immediately, regardless of the above scheduled update
settings.



Troubleshooting

The most common problems users encounter with CAPTURE involve the program failing
to start up properly, the failure to detect connected RAD7s, and errors in downloaded
RAD? data. Solutions to these issues are described below.

CAPTURE Fails to
Launch

If CAPTURE starts but fails to display the splash screen and the Main Window, it is often
the result of a problematic preferences file. The solution is to restore the default
preferences file. This is achieved by holding the Shift and Control keys as CAPTURE starts
up. A dialog box will appear prompting for a confirmation to proceed with the operation.

CAPTURE

Do you want to restore the default Preferences?

If you restore the default preferences, your current Capture settings will be lost.

Restore ] [ Cancel

If this dialog box is not immediately visible, check to make sure that it is not hidden
behind a folder window. Once the preferences have been reset, CAPTURE will start up
normally (although custom-configured RAD7 profiles and other settings will be lost.)

RAD7 Detection
Failure

If CAPTURE is unable to detect a connected RAD?, check the following:

e Make sure the RAD7 is connected to a serial port using the supplied null-modem
cable, or to a USB port using the supplied USB/RS232 adaptor and appropriate
drivers.

e Make sure the RAD7 is turned on.

¢ Make sure the RAD7's battery is charged.

e Make sure the cable connections are secure.

* Make sure the RAD7 has RADLINK installed. (To verify that it is installed, use the
keypad to navigate to the Special menu, and press Enter. If Special commands are
available, then RADLINK is installed correctly.)

¢ Make sure no other application is communicating through the computer's serial
ports.

After performing the above checks, if the RAD7 is still not recognized, try restarting the
RAD? and your computer. Note that it is possible to download data from a RAD7 that
does not have RADLINK installed, using the Manual Download procedure described in
the Basic CAPTURE Functionality section.

RAD7 Data Errors

Whenever RAD7 Data is opened from disk, downloaded from the RAD7, or merged using
the Combine Data command, the data is evaluated and any problems are reported in the
Errors Window. Though data that is thoroughly corrupted is of no use, CAPTURE is often
able to salvage valid records and save them in a "Cleaned Up" R7CDT data file.

The Errors Window displays each line of corrupted data along with an explanation of the
problem. Depending on the context of the problem, the Errors Window may contain up to
three buttons, labeled Continue, Cancel, and Export Cleaned Up Data.



RADT_1.r7cdt: Errors

The following errors were detected while parsing data:

Alert: One or more lines contain an incorrect number of data fields. Some records may have been skipped during the transfer. It may be helpful to
download the data again.

Error: Line &: This line does not contain the required number of data fields.
008,11,05,21,20,30, 41,, 23.0,39.0, 7.3, 49.34,2 7218, 9,33.5, 3, 7,7.09, 00,140, 33.59554,53 40.55331,254

Errar: Line 14: This line does not contain the required number of data fields.
014,11,05,21,23,30, 43, 25.0,41.9,11.6,18,6,23.3,46 2215, 8, 22.5, 3,0,7.12, 00,140, 45.52704, 41,67783,254

Export Cleaned Up Data... : Cancel | [ Continue

If RAD7 Data has just been downloaded, the Continue button saves the acquired data to
disk. The data is saved as a R7RAW file, which includes all erroneous records in addition
to valid data. If the Show Radon Graph checkbox had been checked in the Main Window,
all of the valid RAD7 Data is then displayed in a graph. The Graph Window does not
display any invalid records.

If data was not just downloaded, and an existing RAD7 Data File was simply reopened for
graphing in CAPTURE, the Continue button causes to program to ignore invalid records
and proceed to the Graph Window.

The Cancel button prevents any downloaded data from being saved to disk, and the
Graph Window does not appear.

The Export Cleaned Up Data button makes it possible to save only valid RAD7 Data to
disk, while discarding invalid data. Clicking this button brings up a Save As dialog, which
prompts you to specify a name and location for the cleaned up data. The resulting file is
saved in the R7CDT format, which differs from R7ZRAW data only insofar as it has been
processed and stripped of problematic records.




Appendix A: Menu Commands

CAPTURE's menu bar houses several commands that are not accessible elsewhere in the
user interface. The location of certain menu items may differ depending upon the platform
on which CAPTURE is running. Several menu commands have keyboard shortcuts, which
are listed below, under the description of each item. On Microsoft Windows, the Control
key is used in conjunction with another key to trigger a keyboard equivalent, while the
Macintosh utilizes the Command key for this purpose.

File Menu

Open Data File...

Opens an existing RAD7 Data File, in all supported formats. Keyboard shortcut:
Control/Command-O.

Open Recent

Opens an recently opened RAD7 Data File, in all supported formats.

Close

Closes the window that is currently in front. If the Graph Window is in front, closing it,
brings the Main Window to the front. Closing the Main Window causes CAPTURE to quit.
Keyboard shortcut: Control/ Command-W.

Export RAD7 Output...

Exports the contents of the RAD7 Output text area, which is located in the Issue RAD7
Command panel. This menu item is only available when in Issue RAD7 Command mode.

Export Selected Data...

Provides several RAD7 data export options. These include Cleaned Up Data, Column-
Based Text to File, Column-Based Text to Clipboard, Data Summary, Run Summaries, and
RAD? Printer Data. This command is only available if RAD7 data has been downloaded or
opened from disk, and if the selection contains one or more data points. Detailed
information on these exporting options is available in the Exporting RAD7 Data section.

Save Graph Picture...

Saves the graph picture to disk. On Windows and Linux, the picture is saved as a BMP
file. On the Macintosh, the picture is saved as a PICT file. Note that PICT files are not
always readable on the Windows and Linux platforms. Therefore it is advised that PICT
images be converted to a cross-platform format before being shared with Windows or
Linux users. As an alternative to the Save Graph Picture command, Macintosh users may
prefer to use the Print command to save graph images in the cross-platform PDF format,
which described below. This command is only available if the Graph Window is visible.

Combine Data...

This command combines two or more data files on one graph. Records separated by fewer
than a specified number of minutes are averaged. The combined data may be graphed
and/or saved to disk. More information is available in the Special File Operations section.
Show Data File...

This command reveals the current RAD7 data file in Windows or in the Macintosh Finder.

Show Chart Recorder Logs

This command reveals the folder containing logged Chart Recorder data files. This data



accumulates automatically whenever CAPTURE's Chart Recorder is in use. The files may
be safely moved or deleted at any time.

Page Setup...

This command is used to configure print settings. Before printing a radon graph, it may be
useful to choose the Page Setup command and set the page orientation to Landscape, so
that the graph will fill the page more effectively. This command is only available if the
Graph Window is visible. Keyboard shortcut: Control/ Command-Shift-P.

Print...

Prints the current radon graph. On the Macintosh, the Print dialog box may be used to
save, fax, or email a cross-platform PDF version of the graph image. This command is only
available if the Graph Window is visible. Keyboard shortcut: Control/ Command-P.

CAPTURE Preferences

Displays the Preferences Window, which contains controls used to specify a wide range of
options as described in the Preferences Window section. Note that on the Macintosh, the
Preferences menu command is located under the Application menu. Keyboard Shortcut:
Control/Command-Comma.

Exit

Exits CAPTURE. Note that on the Macintosh, the Exit menu command is labeled Quit and
is located under the Application menu.

Edit Menu

Cut

The Cut command may be used while editing text in various fields throughout the
application. Keyboard shortcut: Control/ Command-X.

Copy Graph Picture

If the Graph Window is open, the Copy Graph Picture command puts the graph image on
to the clipboard. Once the graph image is on the clipboard, it may be pasted into a
graphics application where it can be edited or saved. Keyboard shortcut:
Control/Command-C.

Paste

The Paste command may be used while editing text in various fields throughout the
application. Keyboard shortcut: Control/ Command-P.

Clear

The Clear command may be used while editing text in various fields throughout the
application.

Select All

The Clear command may be used while editing text in various fields throughout the
application. Keyboard shortcut: Control/ Command-A.

View Menu

Concentration Units

Determines the unit of measurement used to denote radon concentrations on the graph.
The available options include Automatic, Bq/m3, dpm/L, and pCi/L. The Automatic



option causes the radon concentration to be presented in the unit in which it was
originally recorded inside the RAD?. This command is only available if the Graph Window
is visible.

Temperature Units

Determines the unit of measurement used to denote temperature data on the graph. The
available options include Automatic, Celsius, Fahrenheit, and Kelvin. The Automatic
option causes the temperature data to be presented in the unit in which it was originally
recorded inside the RAD7. This command is only available if the Graph Window is visible.

Forced SNIFF Mode

Determines whether the graph data is forced to be displayed as if it was recorded in
SNIFF Mode. This menu command is enabled whenever there exists at least one record
that truly was recorded in SNIFF Mode. Such records are analyzed to determine the
necessary SNIFF sensitivity data.

Correct for Humidity

Determines whether the graph data is corrected for humidity. When relative humidity is
high, radon concentration values are often underreported. Humidity correction
compensates for this.

Correct for B to A Spill

Determines whether correction is applied based on the spill from the B to A windows.
Significant spill occurs when the thoron concentration is high relative to the radon
concentration. Under these conditions it is recommended that the data be corrected to
compensate.

Point Style

Determines the appearance of the data points on the graph. The options are Normal,
Shapes, B&W (Black and White) Shapes, and Hidden. The B&W Shapes option causes the
graph to be rendered in black and white, which is useful when graph image is printed on a
non-color printer.

Line Weight

Determines the thickness of the graph lines, as measured in pixels. This value may range
from 1 to 4, or lines may be hidden. A thicker line may be easier to read, but is somewhat
less precise than a single-pixel line. This command is only available if the Graph Window
is visible.

Smoothing

Determines the degree of smoothing applied to the graph line. This value may range from
1 (no smoothing) to 9 (high smoothing). When the degree of smoothing is greater than 1,
the original, non-smoothed graph line appears faded in the background. This command is
only available if the Graph Window is visible.

Show Grid Lines

Determines whether horizontal and vertical grid lines are visible on the graph.

Show Graph Legend

Determines whether the legend is visible on the Graph Window. The legend indicates the
significance of the colors that appear on the graph. This command is only available if the

Graph Window is visible.

Show Error Bars



Determines whether error bars are visible on the graph. Error bars indicate the uncertainty
of radon and thoron readings.

Show Selection Average

Determines whether a representation of the average of the selection is displayed between
the Selection Bars.

Zoom In

Causes the radon graph to zoom in, displaying a shorter time range in greater detail. This
command is only available if the Graph Window is visible. Keyboard shortcut:

Control/ Command-Plus.

Zoom Out

Causes the radon graph to zoom out, displaying a greater time range in lesser detail. This
command is only available if the Graph Window is visible. Keyboard shortcut:

Control/ Command-Minus.

Radon/Thoron/Temperature/Relative Humidity Scale

These menu options determines whether the Y scales of each data type is determined
automatically or manually. Manual Y scale settings for radon, thoron, temperature, and
relative humidity may be configured in the Graph Controls Window.

Graph Lines
Determines which data lines are visible on the graph. The possible graph lines include

Radon, Thoron, Radon in Water, Thoron in Water, Air Temperature, Water Temperature,
and Relative Humidity.

Window Menu

Show Log Window

Determines whether the Log Window is visible. This window contains a record of the
operations that CAPTURE has performed since the application was launched, plus a log of
the data that has arrived through each serial port. Keyboard shortcut: Control/ Command-
L.

Show Spectrum

Determines whether the Spectrum panel is visible. This command is only available when
the Graph Window is visible.

Show Statistics

Determines whether the Statistics panel is visible. This panel displays a range of
information on the data being displayed on the graph. This command is only available
when the Graph Window is visible.

Main Window

Opens the Main Window, if necessary, and brings it to the front.

Clean Up Window Arrangement

Moves each open window to its default location on the screen. If multiple graph windows
are visible, they are arranged in a cascading pattern such that each window's title bar is

visible.

Graph Window Menu Items



The Window Menu contains the names of each of the Graph Windows that is currently
open. Selecting a Graph Window here brings it to the front.

Help Menu CAPTURE Help...
Displays the CAPTURE User's Manual.
About CAPTURE...
Displays the CAPTURE About Box, which provides basic information about Capture, as

well as buttons for accessing Help and Credits. Note that on the Macintosh, the About
option is located under the CAPTURE Menu.



Appendix B: Toolbar Commands

CAPTURE's Main Window contains a toolbar providing quick access to important
functionality. The toolbar can be used to open RAD7 data files, switch between connected
RAD7s, and perform utility operations such as renaming a RAD7 and downloading data
from all connected RAD7s.

These commands are described in detail below.

Open File Button

The Open File button brings up the Open Dialog, in which a RAD7 data file may be
selected for graphing. Details are available in the Opening Data From Disk section.

RAD?7 Selection Buttons

Each connected RAD7 is represented as a toolbar button, labeled with a serial number or
custom RAD7 name. The content of the Main Window pertains to whichever RAD7 is
currently selected in the toolbar.

Add RAD7 Button

The Add RAD? button manually adds a new RAD?. It is necessary to add a RAD7
manually when it does not have RADLINK and can not be discovered automatically, or
when the RAD7 is being reached via a dial-up modem or a local network. When a RAD7

is added manually, the Connection Settings panel appears. This panel is described in detail
in the Main Window section.

Options Menu

# -

Options

RAD7T Connection Settings...
Rename RADT...

Download Data From All RADTs...
Rescan for RADTs

Dizconnect Current RADT
Disconnect All RADTs

Figure 1: The Options Menu in the Main Window toolbar.
The Options Menu is labeled with a gear icon and consists of several commands:

RAD?7 Connection Settings

The RAD7 Connection Settings command brings up the Connection Settings panel, which
can be used to change the specified serial port and/or baud rate of the selected RAD?. It is
also used when connecting to a RAD7 via a dial-up modem or a local network. The
Connection Settings panel is described in more detail in the Main Window section

Rename RAD?...

The Rename RAD7 command brings up a dialog box in which a new name for the selected
RAD?7 may be entered. The specified name appears under the RAD7's icon in the toolbar.
If no name is specified, the RAD? is referred to by its serial number. RAD7 names may
also be changed in the RAD7 Profiles panel in the Preferences Window.

Download Data From All RAD7s



The Download Data From All RAD7s command makes it possible to quickly obtain all of
the raw data from each connected RAD7. This process is described in the Downloading
From All RAD7s section.

Rescan for RAD7s

The Rescan for RAD7s command detects all of the RAD7s that are attached to the
computer and adds them to the CAPTURE toolbar. Any RAD7s that were detected
previously are removed, then rediscovered. The Rescan for RAD7s button at the lower
right corner of the Main Window performs the same function as this menu command.

Disconnect Current RAD7
The Disconnect Current RAD7s command disconnects only the currently selected RAD?. It
may later be restored by rescanning for RAD7s or by adding the RAD7 manually.

Disconnect All RAD7s
The Disconnect All RAD7s command disconnects all RAD7s, leaving the Main Window
empty. RAD7s may later be restored by rescanning or by adding them manually.



R7RAW Data

R7CDT Data

TXT Text Document

PNG Image File

PDF Document

Appendix C: File Formats

CAPTURE utilizes several file formats during the retrieval, editing, and exporting of RAD7
Data. Several legacy formats are also supported, ensuring compatibility with a wide range
of existing data. Each supported RAD7 Data format and image file format is described
below.

When radon concentration data is retrieved from the RAD?, it is normally recorded to disk
in the R7RAW format. A R7RAW file is a plain text file containing up to 1000 rows of
numerical data. Each row is divided into 23 unlabeled columns, separated by commas.
Although this text is not easily human readable, it is well suited for graphing and analysis
within CAPTURE. R7RAW files represent original, unedited data, straight from the
instrument. As such, CAPTURE does not allow a R7ZRAW file to be modified and then
saved back to disk under its original name, even for the purpose of removing unwanted
flaws in the data. If a RZRAW data is modified in any way within CAPTURE, it is only
saved back to disk in the R7CDT format, which represents changed, or "cleaned" data.

Note that CAPTURE can open files using unrecognized file name extensions. Users who
have renamed their R7ZRAW data files using custom extensions such as DAT and CAP will
still be able to view graphs of their RAD? files.

Earlier versions of CAPTURE used the RAW file name extension instead of R7ZRAW. This
has been changed to avoid conflicts with unrelated files that use the same extension.

The R7CDT file name extension represents either "complete data" or "cleaned-up data".
R7CDT files contain RAD7 data has been downloaded and modified in such a way that it
is no longer "raw" data. These modifications may include the removal of one or more lines
of unreadable "garbage" information, or more significant changes, such as the cropping or
combining of data, or the addition of RAD7 printer output and device information. R7CDT
files containing this extra information are created when an Automatic Download procedure
is performed with the "Obtain Supplementary Data" checkbox checked. R7CDT files may
also be created using the File menu's Export Data command.

Earlier versions of CAPTURE used the CDT file name extension instead of R7CDT. This
has been changed to avoid conflicts with unrelated files that use the same extension.

A TXT (Text) file is a plain text document that can be opened in any text editing or word
processing application. The Export Data command provides the ability to save cleaned up,
tab-delineated RAD7 Data to a text file. By inserting tab characters to separate columns of
data, CAPTURE produces files whose contents can be imported directly into software such
as Microsoft Excel for further analysis.

TXT files may also contain RAD7 Data acquired directly from a measuring device. These
TXT files are functionally identical to R7ZRAW files, and can be opened and graphed in
CAPTURE.

When a graph image is saved using the Save Graph Picture command, CAPTURE
produces a PNG image file. The PNG format uses compression to ensure small image file
sizes, without sacrificing image quality.

The PDF file format is a cross platform format produced by the Macintosh version of
CAPTURE when exporting graph images from within the Print dialog box. Since the
system can save, fax, and email PDF documents using this dialog, it is sometimes
preferable to export PDF graph images using the Print command, rather than exporting
PNG graph images using the Save Graph Picture command on the Macintosh.



Appendix D: Version History

The following version history is presented with the most recent changes first.

Version 4.8.4:

e Humidity Correction is now applied to records using a checkbox in a manner
similar to B to A Spill Correction and Forced SNIFF Mode.

¢ The new "Download data from All RAD7s" command makes it easy to quickly
obtain the raw data from all connected RAD7s.

¢ RAD7s may now be renamed. When a RAD? is detected, its custom name appears
under its icon in the toolbar, making it easier to locate a particular device.

e CAPTURE no longer mistakes incompatible serial devices for RAD7s.
¢ RAD7 port and baud rate settings can now be changed with greater reliability.

e Date and time labels may now be formatted with either a 12 or 24-hour clock,
overriding the operating system's settings. Custom date formatting may be used
when exporting data to a column-based text file.

Version 4.8.3:

¢ The Windows version of CAPTURE now identifies serial ports and connects to
RAD7s more quickly. Significant performance improvements have been achieved in
configurations involving multiple RAD7s.

¢ The Statistics and Spectrum panels have been integrated into the Graph Window,
resulting in a streamlined and more intuitive user interface.

« It is now possible to specify a custom drying unit volume when opening BIG
BOTTLE RAD H,0 data.

» The Log Window now contains a set of lists showing the data that has been received
through each serial port.

 The stability and responsiveness of CAPTURE have been improved on Windows.
The screen now refreshes more quickly, without flickering.

e Humidity correction is now applied to calculated radon in water values.

e Automatic update checks may now be performed whenever CAPTURE launches.
This has been made the default option.

Version 4.8.2:

» CAPTURE no longer crashes on the Macintosh. The Spectrum Window has been
temporarily disabled to address this situation.

» Radon in Water graph points are now accurately rendered when graphing BIG
BOTTLE RAD H,0 data.

Version 4.8.1:

e The Chart Recorder now logs RAD7 data to disk in real time.

e The Chart Recorder has been made more responsive and robust, obtaining data and
refreshing itself in the background.

e Charts may now contain multiple data runs, including sequences of over 99 records.
 Printer output data is now preserved when combining RAD7 data sets.

e Thoron in Water concentration readings are now scaled to compensate for thoron's
brief half life.



* When graphing RAD7 data acquired using the RAD AQUA or Water Probe, records
lacking corresponding water temperature data may now appear on the graph.

» The Windows version of CAPTURE has been made significantly more stable.

Version 4.8:

o« CAPTURE is now able to calculate Radon in Water concentrations for data obtained
using the BIG BOTTLE RAD H;0 accessory for the RAD?.

o The Chart Recorder has been made more reliable and responsive.

Version 4.7.8:

e The new R7CDT and R7RAW file formats have been introduced to replace the CDT
and RAW file formats, resolving conflicts with unrelated formats that share the same
file name extensions.

 The synthetic peaks displayed in the Spectrum Window are now generated based on
real-world data samples and rendered with high precision.

 File associations have been resolved in the Windows version of CAPTURE. It is now
possible to open a RAD7 data file in CAPTURE by double-clicking it.

e The Chart Recorder now refreshes every 5 minutes instead of every minute. This
makes CAPTURE's user interface more responsive and frees up the RAD7's CPU to
process more counts per cycle.

¢ The functionality of the pop-up menus above the Chart Recorder has been restored.

» Exporting a selection as cleaned up RAD7 data no longer results in file corruption.

Version 4.7.7:

 Printer output containing radon concentrations in excess of 1 million units no longer
compromises data integrity.

 The functionality of the Open Recent menu in the Main Window has been restored.

Version 4.7.6:

¢ An issue preventing multiple RAD7 data files from being merged has been resolved.

» The CAPTURE source code has been prepared for eventual compilation on the Mac
OS X Cocoa platform.

Version 4.7.5:

 Printer data is now parsed more reliably: readings containing very high
concentrations of Thoron no longer result in miscounted output records, and the
time at which the record was recorded no longer impacts parsing accuracy.

¢ The Chart Recorder's status panel now properly recognizes when a RAD7 is
performing WAT and GRAB operations.

« File info sets are now maintained for CDT files that include printer output,
permitting graph viewing settings to be saved on a per-file basis more effectively.

Version 4.7.4:

e The Download RAD7 Data interface has been streamlined.

¢ When no RAD? is connected, manual download and scanning functionality is now
more easily accessible.



e The new 'Match Significant Figures to Precision' preference makes it possible to
format highly uncertain values using fewer significant figures.

« It is now possible to export printer output from graphs created from within the
Chart Recorder.

« High thoron concentrations and uncertainties are now parsed properly for records
recorded in Thoron mode.

e CAPTURE is now better able to determine whether the pump was on during
particular cycles.

¢ Unaltered raw RAD7 output and printer output are now stored as comments within
CDT files.

« It is now possible to drag files onto the closed CAPTURE application icon on
Windows.

Version 4.7.3:

¢ The horizontal grid lines are now drawn in the correct location on radon graphs.
CAPTURE now scans for attached RAD7s automatically by default.

e Dense graph data is now more easily viewed when Error Bars are enabled.

Dotted lines representing areas of unknown humidity are now rendered properly.

Version 4.7.2:

¢ The appearance and behavior of the real-time Chart Recorder have been improved.
It contains more responsive interface controls, and the system now keeps track of
which data points belong to which runs.

e The default window configuration and graph appearance have been simplified,
making it easier to get started with CAPTURE.

» Most user preferences are now reset when opening a new version of CAPTURE for
the first time, ensuring reasonable window positioning.

e Automatic and Manual downloading operations are now carried out from within the
same panel in the Main Window.

Version 4.7.1:

» The Main Window no longer reappears unexpectedly when performing certain
Graph Window operations.

e The Export Run Summaries feature now starts counting from the specified record.

Version 4.7:

¢ The new Chart Recorder panel contains real-time information about the state of each
connected RAD?7, including a graph of data points as they accumulate. Menus for
starting, stopping, and configuring the RAD7 are also provided.

 Foreign language translations may now be restricted to human-translated languages
or disabled entirely, overriding the operating system's settings.

e Run summary information may now be exported to a text file, as part of a
streamlined Export interface.

¢ Graph appearance and rendering performance have been improved.

o It is now possible to display selection averages and uncertainties for Radon in Water
and Thoron in Water.

e The information panel at the top of the graph window has been redesigned to
display more pertinent data.



Concentration and uncertainty values are now formatted using the appropriate
number of significant digits.

 The system for assigning RAD7 profiles to data files has been improved.

¢ Radon and thoron counts are now calculated more accurately.

Version 4.6:

e CAPTURE now supports multiple simultaneous RAD7 connections. Communication
operations may be completed in parallel.

¢ A redesigned Connection Panel makes it easier to connect to local and remote
RAD?7s. The Main Window's toolbar provides convenient access to each connected
RAD?.

e The connection framework is now more robust, for more effective network and
modem-based communication.

* Security features now protect RAD7s from receiving communications from
unauthorized remote computers.

» CDT files now include RAD? printer output in a human-readable form.
* It is now easier to configure CAPTURE to relay RAD7 commands over the Internet.

e Stability and performance have been improved throughout the application.

Version 4.5.1:

o CAPTURE now tolerates inconsistencies between RAD7 data records and
supplementary data obtained through printer output.

e Low concentration averages are now represented correctly on the graph.

e Combining RAD7 data files now works reliably. If the combined files are known to
have been recorded using the same RAD7, the device data is retained.

e Exported CDT files now include any available supplementary data.
 Visual glitches have been addressed in the Preferences Window.

» Download operations may now be cancelled and restarted more reliably.

Version 4.5:

 Data pertaining to thoron and runs that was previously available only through the
infrared printer can now be downloaded and stored in the CDT file format.

« It is now possible to download a specific run, in addition to all runs or the latest
run.

+ The thoron calculation algorithm has been improved. CAPTURE now displays a
representation of the minimum meaningful thoron, and indicates when the CB spill
is excessive and thoron can not be known.

 Error bars and selection uncertainty regions may now be displayed on the graph.

o The appropriate RAD7 Profile is automatically selected when viewing RAD7 records
containing supplementary data.

e When exporting RAD7 data it is now possible to specify whether the derived
concentration values are calculated with respect to Forced SNIFF Mode and B to A
Spill Correction.

¢ The exported Data Summary file may now contain detailed RAD? specifications.

« The Statistics Window now contains an expanded assortment of information
pertaining to the RAD7 and the point nearest the cursor.

¢ Graphs may now display error bars indicating concentration uncertainties.

¢ Various warning messages may now be toggled on and off in the redesigned
Preferences Window.



Support for records in WAT250 and WAT40 mode has been improved.

Version 4.4.10:

¢ CAPTURE now supports B to A spill correction. This option may be enabled in the
Graph Controls Window.

¢ The Clean Up Window command now respects MDI settings on Windows.
¢ Graph points may now be displayed as shapes.

e Graphs may now be rendered in monochrome for compatibility with black and
white printers.

Version 4.4.9:

» It is now possible to graph records containing unknown humidity data. Periods of
unknown humidity are represented on the graph using dotted lines.

¢ Graph line smoothing now uses a superior distribution algorithm based on Pascal's
Triangle.

e The RAD7 detection process now operates more reliably.

e Issuing certain commands on the RAD7 keypad no longer compromises subsequent
download operations.

 Visual glitches in the Graph Controls Window have been addressed.

Version 4.4.8:

 Certain window layout configurations no longer prevent CAPTURE from starting up
properly on Windows.

» Miscellaneous usability improvements have been implemented.

Version 4.4.7:

¢ CAPTURE can now automatically check for updates and download the necessary
installer (Windows) or disk image (Macintosh).

¢ The RAD? settings interface has been streamlined and is now more user-friendly.

o It is now possible to download the latest run from a RAD7 that is set to a low baud
rate.

¢ RAD7 scanning performance has been improved; CAPTURE now begins by
scanning at the baud rate at which a RAD7 was most recently found.

 Graph selection bounds no longer "drift" when dragging the Zoom Slider.

¢ Window layout has been improved on Windows 7 and on computers with smaller
displays.

¢ The Clean Up Window Arrangement command displays application windows in
cascading layout for easier access to each graph.

Version 4.4.6:

e Internal enhancements now allow for more streamlined RADY7 calibration and
firmware configuration.

Version 4.4.5:

¢ Records with differing Flags Bytes and Units Bytes may now be combined and



averaged.

¢ The serial port detection process has been changed to eliminate unnecessary delays
while launching CAPTURE.

e The new Show Data File command reveals RAD7 data files on disk.

¢ Humidity correction can now be applied to data recorded outside the standard
range of dew point conditions.

 Corrected code logic for determining radon counts.

¢ Uncertainties may now be calculated using one of two formulas. Thoron
uncertainties may now be viewed and exported.

Version 4.4.4:

¢ Graph navigation operations have been stabilized and streamlined.

¢ The uncertainty values of combined records are now computed more accurately.

Version 4.4.3:

e The Image Output preferences panel may be used to control print settings and to
configure the appearance of saved graph images.

o It is now possible to create a new selection by dragging the cursor across the graph.

» A contextual graph menu provides quick access to common operations.

Version 4.4.2:

¢ Radon concentration uncertainty is now reported correctly for the point closest to
the cursor.

¢ The humidity correction algorithm has been refined and is now more accurate.

e Printed graphs now include statistics. The graph legend and labels are now larger
and easier to read.

Version 4.4.1:

e Concentration averages are now reported correctly when converting between units.

Version 4.4:

» Graphs may now display radon in water, thoron in water, air temperature, water
temperature, and relative humidity.

e The Graph Controls Window now consists of multiple collapsible panels to make
better use of screen space.

e The graph Y Axes may now be individually controlled for radon, thoron,
temperature and humidity. Slider controls facilitate improved graph navigation.

Version 4.3.9:

» An issue preventing Manual Download button from becoming active has been
resolved.

Version 4.3.8:

» Exporting RAD7 data that has been combined using the Combine Data operation



produces accurate uncertainty results.

¢ A more modular internal data structure improves CAPTURE's performance and
scalability.

¢ On computers set to display Traditional Chinese text, CAPTURE will now use
Simplified Chinese rather than English.

Version 4.3.7:

e It is now possible to perform automatic and manual downloading operations
remotely via dial-up modem and Internet connections.

¢ Miscellaneous improvements have been made in the areas of usability, connectivity,
and error reporting.

Version 4.3.6:

¢ The process of scanning for connected RAD7s is now more user-friendly.

e Error handling has been enhanced, with additional options providing greater
flexibility.

Version 4.3.5:

e CAPTURE can now communicate with remote RAD7s that are connected to the
Internet via computer or wireless serial communications device.

e It is now possible to configure CAPTURE to relay commands from a remote
computer to a connected RAD7.

¢ A wide range of RAD7 data fields may now be exported as tab-delineated data.

Version 4.3.4:

e The Combine Data feature now allows the user to specify whether the combined
data is graphed and/or saved to disk. The maximum permitted record separation
value is now interpreted using a more advanced algorithm.

e Temperature Data Profiles now support dates formatted by Day/Month/Year and
Year/Month/Day. This makes it possible to configure Temperature Data Profiles for
Lascar Electronics EasyLog data files. Support for such files is now built-in.

¢ Any newly introduced built-in Temperature Data Profiles are automatically added
to the user's collection of Temperature Data Profiles when an updated version of
CAPTURE is used for the first time.

* Any built-in Temperature Data Profiles that have been deleted by the user can now
be restored reliably using the Restore Built-In Profiles button in the Preferences
Window.

¢ Numbers are now formatted with respect to the influence that insignificant digits
exert over significant digits. Specifically, when a decimal value is displayed the final
significant digit is now rounded up when the value of the first insignificant digit
(the one immediately to the right of it) matches or exceeds 5.

¢ The graph label drawing code has been improved; label borders are now cropped to
the ideal size.

¢ When translating from radon concentration in air to radon concentration in water,
the uncertainty value is translated accordingly.

» CAPTURE now alerts the user when relative humidity readings are excessively high,
and provides suggestions for possible corrective actions.

Version 4.3.3:



¢ CAPTURE now handles a more diverse range of temperature data file formats.

¢ Derived RAD7 data is now protected when the Combine Files feature is used.
Previously this information could be lost.

o It is now possible to restore the built-in Temperature Data Profiles from within the
Preferences Window.

Version 4.3.2:

¢ Temperature Data files may now be applied to RAD7 data recorded using the RAD
AQUA accessory.

e It is now possible to download the latest run, as an alternative to downloading all
RADY7 data.

« It is now possible to begin performing RAD7 communication operations while
CAPTURE continues to scan for additional serial ports in the background.

 After downloading data from a RAD?7 that is nearly full, CAPTURE offers to erase
the RAD7 memory to make room for more records.

» RAD7 Data is protected from erasure until it has been downloaded in its entirety.

¢ SNIFF Sensitivity is now computed correctly for files whose radon values are stored
using scales other than pCi/L.

« Download buttons are enabled even if a download location has not been chosen.
¢ The BA Spill Factor now defaults to 0.4 when creating a new RAD7 Profile.

¢ Appending downloaded RAD7 data to an existing file now works reliably.

o The default BA Spill Factor is now 0.05.

Version 4.3.1:

e The Main Window interface has been improved and simplified.

» CAPTURE now automatically detects any connected RAD7s and identifies each
device's port and baud rate.

Version 4.3:

¢ RAD7 Data may now be downloaded remotely, without having to press any buttons
on the RAD? itself.

» Various other commands may be sent from CAPTURE to the RAD?.

« CAPTURE now supports the importing of temperature data files. Customizable
Temperature Data Profiles allow any type of text-based temperature file to be
imported. (Temperature and RAD7 data integration is forthcoming.)

e Numerous user interface enhancements make CAPTURE easier to use.

Version 4.2.4:

* Sensitivity readings are now reported correctly when listed in Bq/m? units.

Version 4.2.3:

e CAPTURE now keeps track of associations between RAD7 Profiles and RAD7 Data
Files. Beyond a limit of 1024 pairings, the least recently accessed pairings are
purged.

¢ Graph rendering speed has been significantly increased, particularly when
smoothing is enabled.



e Spectrum CPM labels are again visible.
 Selection Bar labels are again visible.

e Smoothed graph lines no longer appear near the start and end of runs. The exact
smoothing threshold depends on the selected smoothing degree.

 Existing CAPTURE Preferences data is no longer discarded when updates are
installed.

Version 4.2:

e New graphing feature: Forced SNIFF mode.

¢ An unlimited number of RAD7 profiles may now be configured in the preferences.
» RADY profiles now include the BA Spill factor.

« It is now possible to specify custom colors for each graph line.

¢ The Statistics Window now displays RAD7 information.

¢ The Statistics Window may now be scrolled, and individual statistics panels may
now be independently collapsed and expanded.

¢ The Macintosh version of CAPTURE now saves graph pictures in a 64-bit compatible
PNG format.

¢ Numerous bug fixes and improvements have been made to ensure cross-platform
parity.

Version 4.1:

¢ CAPTURE now displays humidity-corrected Radon and Thoron.

¢ The user interface has been significantly enhanced.

e Multiple graphs may now be displayed simultaneously.

e A Spectrum Window has been added.

 The Statistics window now displays information on the point under cursor.

* Improvements have been made to the algorithms used to generate derived data.

¢ Numerous additional Export, Join, and Combine options.

Version 4.0:

e This is the first full-featured release of CAPTURE for Macintosh and Windows.

Versions 1.0-3.5:

The earliest versions of CAPTURE were made available for DOS. The software was capable
of downloading RAD7 data, but graphing was not supported. Graphing was first
implemented in internal test builds of CAPTURE, starting with version 3.0.
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